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About This Guide

This user guide provides information to help you:

• Understand features and functionality of L&TT
• Effectively use the full functionality of L&TT to obtain maximum performance from your storage

hardware, and to test, diagnose, and resolve hardware issues

“About this Guide” topics include:

• Overview
• Conventions
• Getting Help

Overview
This section covers the following topics:

• Intended Audience
• Prerequisites

Intended audience
This book is intended for:

• Users who want to use L&TT to conveniently update firmware in their storage hardware
• Users who need to test, diagnose, and resolve storage hardware issues
• Support technicians
• Call center personnel

Prerequisites
Before you attempt to use L&TT, you should have a basic understanding of the following technologies:

• Storage hardware functionality and operation
• SCSI operation

Conventions
Conventions consist of the following:

• Document Conventions
• Text Symbols

Library and Tape Tools User GuideProduct Version: 3.5 SR4 9



Document conventions
The document conventions included in Table 1 apply in most cases.

Table 1 Document conventions

Element Convention

Cross-reference links Figure 1

Key and field names, screen names, menu items,
buttons, and dialog box titles

Bold

File names, application names, and text emphasis Italics

User input, command names, directory names, and
system responses (output and messages)

Monospace font

Variables <monospace, italic font enclosed in
angle brackets>

Web site addresses Underlined sans serif font text:
http://www.hp.com

Text symbols
The following symbols may be found in the text of this guide. They have the following meanings.

WARNING!
Text set off in this manner indicates that failure to follow directions in the warning could result in bodily
harm or death.

CAUTION:
Text set off in this manner indicates that failure to follow directions could result in damage to equipment
or data.

NOTE:
Text set off in this manner presents commentary, sidelights, or interesting points of information.

Getting help
If you still have a question after reading this guide, contact an HP authorized service provider or access
our web site: http://www.hp.com.

HP Technical Support
Telephone numbers for worldwide technical support are listed on the following HP web site:
http://www.hp.com/support. From this web site, select the country of origin.

NOTE:
For continuous quality improvement, calls may be recorded or monitored.

Be sure to have the following information available before calling:

10 About This Guide
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• Technical support registration number (if applicable)
• Product serial numbers
• Product model names and numbers
• Applicable error messages
• Operating system type and revision level
• Detailed, specific questions

HP authorized reseller
For the name of your nearest HP authorized reseller:

• In the United States, call 1-800-345-1518
• In Canada, call 1-800-263-5868
• Elsewhere, see the HP website for locations and telephone numbers:

http://www.hp.com

Library and Tape Tools User GuideProduct Version: 3.5 SR4 11
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1 Introduction

HP StorageWorks Library and Tape Tools (L&TT) is a collection of storage hardware management and
diagnostic tools for Nearline Tape, Nearline Tape Automation, and Nearline Archival products. L&TT
assembles these tools into a single, convenient program.

Software features
L&TT offers the following features:

• Installation Check—L&TT guides you through a basic installation check of your product. The
software assists the user in choosing an appropriate HBA and SCSI ID(s), ensuring that the device
is detected by the system, and verifying key device functionality.

• Device Identification—L&TT clearly identifies the storage products connected to the system, along
with key information on product configuration and status.

• Troubleshooting Tests—L&TT provides various tests to verify product functionality or to isolate
product issues. Tests include device self-tests, read/write tests on drives, exerciser tests for
autoloaders and libraries, and specific device utilities.

• Firmware Upgrades—L&TT provides a convenient way of updating product firmware, enabling
users with an Internet connection to take advantage of ongoing enhancements. The software can
be configured to check the Web automatically for firmware updates for connected devices, or
users can manually check the Web for updates if the automatic update feature is not desired.
If updated firmware is available, the program notifies the user, and the updates can easily be
copied to the system. With libraries, users can upgrade the library and the embedded drive
firmware in the same operation. Wherever possible, the embedded drives are updated in parallel
to reduce time.

• Support Ticket Generation—If you experience a problem with a storage product, L&TT can
generate a support ticket that includes essential information for troubleshooting the problem.
As an alternative to phone support, you can e-mail the support ticket to a support center for
assistance. This information streamlines the support process and enables the support staff to
better serve you if a support call is made later.
When a support ticket for a device is generated, L&TT performs a Device Analysis test on the
device. The support ticket contains generic information about a device, as well as the results of
the Device Analysis test. The Device Analysis test can be performed by itself, but HP recommends
generating a support ticket because the resulting data is presented in a more useful format.

• Automatic Notification of Web Updates—If a connection to the Internet is present and web
updates are enabled in the tool preferences, L&TT automatically informs you of the following
updates, if available, each time the program is started:
• New versions of L&TT
• New firmware files for connected devices
• New device-specific functionality (such as new or updated tests) for connected devices

Supported products and operating systems
For a complete listing of compatible products, refer to the specifications page at
http://www.hp.com/support/lttcompatibility.

The level of functionality that L&TT offers for each device varies depending on features of the device,
and the degree of device integration into L&TT.
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Finding additional information
The HP web site provides the current version of L&TT for download, and general information about the
tool. Access the web site at:

http://www.hp.com/support/tapetools

Getting support
E-mail support is available from ltt_team@hp.com. You can expect a response within 24 hours (usually
sooner) during a normal business week.

Use this address to obtain support for L&TT to report bugs, to provide feedback on this manual, to report
any issues with the L&TT web site, or to provide enhancement suggestions. HP appreciates feedback on
how to make improvements for future versions of L&TT.

NOTE:
This address is intended to provide support for L&TT software. This address is NOT for assistance
in troubleshooting hardware products. Refer to the documentation that comes with your hardware
for support options for that product.
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2 Installation

This chapter outlines the procedure for installing L&TT on a Microsoft® Windows®, Novell NetWare,
HP-UX, HP Tru64, Linux, or HP OpenVMS platform. The Windows version of L&TT uses a graphical user
interface (GUI). All other versions of the program use a command screen interface (CSI).

The information in this chapter and in subsequent chapters is presented for both the GUI and CSI versions
of L&TT. When using an electronic version of this documentation, click the appropriate link at the
beginning of the chapter to quickly jump to the section of documentation that applies to your operating
system (OS) or user interface.

Select your OS:

Windows

Netware

HP-UX, Tru64, and Linux

HP OpenVMS

Installing L&TT for Windows
The Windows version of L&TT uses the InstallShield application. InstallShield lets you choose the
installation directory and select other options. It also sets up shortcuts to launch the application in the
Start menu and on the desktop. The Start menu shortcuts also provide access to the online help, the
readme file, the report viewer, and the L&TT Installation Check feature.

Upgrading from a previous version of L&TT
You must uninstall any previous versions of L&TT before installing the most recent version. To uninstall
L&TT, use the Add/Remove Programs applet in the Windows control panel. The uninstall procedure
does not remove the installation folder, allowing you to preserve all of your previous L&TT files such as
log files, firmware files, and so forth.

Installation procedure
To install the current Windows version of L&TT:

1. Download or copy the self-extracting executable file to a temporary location.
2. Double-click the self-extracting executable file to launch the installer. The InstallShield Wizard

screen is displayed.
3. Click Next. Read the program license agreement and click Yes if you agree to and accept

the terms of the license agreement.
4. Read the readme file for any last-minute changes to the documentation, then click Next. The

Select Features screen is displayed.
5. Select the desired components to install and click Next.

In most cases, the default settings of this screen are adequate. Windows NT 4.0®, Windows
2000, and Windows XP users have the option to install Advanced SCSI Programming
Interface (ASPI) support. With Windows 9x installations, the ASPI component is required and
automatically included in the L&TT installation process. If ASPI installation is optional with your
OS, HP recommends that you not install ASPI support unless you have a good reason to do so.
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ASPI support is beneficial when installed storage applications cannot be shut down, and those
applications have locked access to the device through the Miniport driver. If ASPI is installed, it is
generally not necessary to shut down these applications to access devices through L&TT (although
the applications should not be accessing the devices while L&TT is running). ASPI lets you run
L&TT on a locked device without rebooting, but a reboot is required after installing ASPI. The
benefit of using ASPI is not realized the first time L&TT is run, but it is realized on subsequent runs.
One drawback of ASPI is that USB drives are not supported. If you have USB drives, you must
use the Miniport driver.

6. Select a destination location to install the program. You can accept the default location or click
Browse to install to a different location. After choosing the destination location, click Next.

7. Indicate the program directory in which you want the setup program to create program icons
and click Next. The program directory is created in the Programs directory of the Start menu.

8. On the Ready to start installation process screen, click Next. If you need to review or change
installation settings, click Back.

9. When installation is complete, click Finish to close the InstallShield wizard.

Reboot criteria
A reboot is required only if your system requires ASPI or an upgrade to the currently installed version. On
systems that require ASPI, if the installer detects a previously installed version of ASPI older than v4.57, it
will install a more recent version of ASPI, which will require a reboot.

On Windows NT and 2000, ASPI is not installed as part of the operating system. If a reboot is
unacceptable, do not select the checkbox for this option in the installation process. If you choose not to
install ASPI, you must use the Miniport driver (Miniport I/O mode) to scan for devices.

Issues may arise, however, when using the Miniport I/O mode with devices that use non-standard OS
drivers, or are “claimed” by other applications or the OS. When using the Miniport I/O mode when a
device is claimed, it may be necessary to shut down any running backup/storage application services
to make the device accessible to L&TT. Alternatively, using the ASPI I/O mode may make the device
accessible without requiring any further action.

Installing L&TT for NetWare
To install the NetWare version of L&TT:

1. Download the L&TT for NetWare file to a temporary directory.
2. From a client workstation, use any standard unzip utility* to extract the file to the SYS:System\

directory on the NetWare server. Make sure that the option to create a directory is enabled
in the archiving software.

NOTE:
* The unzip NLM that comes with later versions of NetWare has not been tested and should not be
used to unzip the archive.

Installing L&TT for HP-UX, Tru64, and Linux
To install L&TT for HP-UX, Tru64, or Linux:

1. Log in as root.
2. Navigate to the temporary directory:

cd /tmp
3. Download or copy the L&TT tar file, hp_ltt<xx>.tar (where <xx> is the version number) to this

directory. If you are copying the file from a different location, enter the following (substitute the
directory in which the file currently resides for <directory name>):
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cp /<directory name>/hp_ltt<xx>.tar /tmp
4. Untar the L&TT tar file:

tar -xvf hp_ltt<xx>.tar

5. Run the install script in the /tmp directory:
./install_hpltt

6. After the software is successfully installed, enter the following commands to remove the
/tmp/ltt directory and its contents:
cd /tmp
rm -rf ltt
rm -rf install_hpltt

Installing L&TT for HP OpenVMS

NOTE:
L&TT is supported on HP OpenVMS v7.3–1 and later.

Installing L&TT
1. Download or copy the install file hp-axpvms-ltt-v<xx>-1.pcsi (where <xx> is the version number)

to a temporary directory.
2. Navigate to the directory you copied the install file to and enter the following command

to install L&TT:
product install
The installation procedure creates the directory structure opt.ltt in sys$sysdevice:[vms$common]
and installs all the required files for L&TT.

3. Set the term to vt100 using the following command:
set term /dev=vt100

4. Define the logical name “USR” so that it points to the directory sys$sysdevice:[vms$com-
mon.opt.ltt.misc.usr] using the following command:
define usr sys$sysdevice:[vms$common.opt.ltt.misc.usr]
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3 Basic Operation

This chapter describes how to start L&TT and the basic operation of the software. This chapter is divided
into two sections: one for using L&TT in a GUI environment (Windows) and one for using L&TT in a
CSI environment (NetWare, HP-UX, Tru64, Linux, and OpenVMS). To quickly jump to the appropriate
section, click one of the following links:

Windows

NetWare, HP-UX, Tru64, Linux, OpenVMS

Starting L&TT

To start L&TT, do one of the following:

• Double-click the L&TT icon on the desktop (if present)
• Click Start > Programs > HP StorageWorks Library and Tape Tools > HP L&TT

Using the splash screen

When L&TT is started, the splash screen is displayed. The splash screen gives you the opportunity to exit
the application before any SCSI bus activity has taken place. This feature lets you exit the application if
it was started unintentionally. This prevents the program from interfering with any backup or other
storage applications that may currently be running.

Library and Tape Tools User GuideProduct Version: 3.5 SR4 19



The splash screen also lets you select the initial scan mode and the SCSI I/O mode (if more than one
option is available).

Figure 1 L&TT splash screen

Scan mode
When L&TT starts, it performs a device scan to identify all the devices connected to the computer, either
directly or through a SAN. In large SAN environments, this scan can take up to 45 minutes or more.

The first time L&TT is run, it must perform a full hardware scan (Hardware Scan option), and the
Saved/Manual Scan option is disabled. The results of the full hardware scan are automatically saved, so
the next time L&TT is started, the Saved/Manual Scan option is available.

NOTE:
If you previously selected the Skip this dialog in the future checkbox on the splash screen, L&TT performs
a full hardware scan. To re-enable the splash screen and change the scan option, select Preferences
from the Options menu. Check the option Display splash screen at startup and restart L&TT.
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If you select the Saved/Manual Scan option and click Continue, the Saved/Manual Scan screen is
displayed.

Figure 2 Saved/Manual Scan screen

Using the Saved/Manual Scan screen
The left panel of the Saved/Manual Scan screen displays the devices that were detected in the last saved
scan. If this list is incomplete (for example, if new hardware has been added since the last scan), click
Scan Hardware Now to rescan the system for new devices. If you want to manually add a device to the
list of devices to be scanned without performing a full hardware scan, click Enter Address Manually.

Use the Select All, Remove All, Select, and Remove buttons to select devices. Selected devices are
displayed in the right panel of the screen, and only selected devices will be scanned and identified by
L&TT. Devices that are skipped will not be displayed in the Device List on the L&TT Main screen.

After selecting all of the devices that you want L&TT to scan and identify, click Continue to perform the
scan and proceed to the L&TT main screen. L&TT saves the list of selected devices, so the next time you
start L&TT and display the Saved/Manual Scan screen, L&TT displays all of the previously selected
devices in the right panel.

I/O mode
L&TT selects the input/output (I/O) mode that is most appropriate for the system it is running on.
However, this initial screen allows for manual selection of the I/O mode in certain cases. L&TT currently
operates in the following two I/O modes:

• NT Miniport—uses an interface that is native to Windows NT 4.0, 2000, XP, and Windows
Server 2003. This is the preferred I/O mode on systems where it is available because it does not
require the installation of the ASPI interface. However, there are some limitations to the Windows
NT Miniport I/O mode related to using devices that are “claimed” by other applications, or
that are used with non-standard OS drivers. In those cases, selecting the ASPI I/O mode can
make a device accessible.

NOTE:
The Windows NT Miniport I/O mode is not available on Windows 9x.
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• ASPI—uses an optional I/O programming interface that is available on all versions of Windows.
This I/O mode can be used with any Windows operating system. It may require the installation or
update of additional OS components, possibly requiring a reboot of the system during installation.

Skip this dialog in the future
If this checkbox is selected when you click Continue, the splash screen is not displayed on subsequent
uses of L&TT. The program will continue to use the settings that you selected the last time the splash
screen was viewed.

To re-enable the splash screen, select Preferences from the Options menu. Check the option Display
splash screen at startup and restart L&TT.

Application window layout

After the I/O mode is selected, click Continue on the splash screen. The L&TT main screen is displayed.
Figure 3 shows the L&TT main screen divided into three sections.

Figure 3 L&TT main screen

The three sections of the L&TT main screen are:

1. Taskbar—This section contains buttons that provide quick access to the main functions of L&TT
and to the online help system.

NOTE:
Above the Taskbar is the standard Windows menu bar that provides alternate navigation to tool
functions, as well as access to a number of other features.

2. Device List—This is a multi-function window that offers several options on the following tabs:
• Scan—This option provides either a summary status or detailed information (depending

on whether Show Details or Hide Details is selected) about the bus scanning process. If
a problem is encountered during the scan, this information may help in determining the
cause. When the scan completes successfully, the device list automatically switches to the
By Product tab.
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The Scan tab also lets you rescan the bus. If any devices have been hot-swapped or powered
on after the OS has booted, in most cases, the rescan feature can discover those devices
without requiring a reboot of the system.

CAUTION:
Swapping SCSI devices, including connecting and disconnecting cables and/or terminators, can
cause the system to hang or crash.

CAUTION:
On Windows NT 4.0, 2000, XP, and Windows Server 2003, changing devices at a specific
SCSI address can cause unpredictable behavior. Parts of the operating system may not detect
that the device or device type has changed.

• By Product—This option shows a list of all the products connected to the system. The list is
grouped into the following four categories:
• Libraries and autoloaders
• Drives
• Enclosures and processors
• Other devices
The three number fields listed after the device represent the device address. Each field in the
address is separated by a period: the first field represents the HBA channel, the second field
represents the SCSI ID, and the third field represents the LUN.

NOTE:
When using the Miniport I/O mode, the HBA channel field is shown as “A/B,” where A is the
channel and B is the subchannel.

• By Connection—This option shows all products connected to the system, grouped by the
HBA they are connected to. This view makes it easy to see which devices are connected
to the same bus as the device in question, and may help in understanding system I/O
performance issues.

• Instructions—This window contains brief instructions on how to use the selected screen. This
view can be disabled in the software preferences.

3. Device Information screen—All the main functions of the program are displayed in this window.
The content of this window depends on the device and tool function selected.

Using the Device Information screen

When you select a product from the Device List, the Device Information screen displays information
relevant to the device. The Device List also changes to display instructions on this page (if the instructions
preference is enabled). If another tool function is currently active, then clicking the Identity button on
the toolbar opens the Device Information screen.

The Device Information screen provides an overview of the selected hardware device and its current
configuration and status.
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Standalone devices
The Device Information screen, showing a standalone device, contains a single tab labeled Drive
Information. The Device Information screen has four main sections, as shown in Figure 4.

Figure 4 Device Information screen showing a standalone device

1. This provides a visual representation of the selected product (the images are in grayscale).

2. This provides the following general information on the product:
• Product ID (Inquiry String)
• Drive Technology (DDS/DL/LTO)
• Mech Serial # (Drive serial number)
• Firmware Revision
• SCSI Target ID
• SCSI LUN

3. If a data cartridge was inserted in the drive when the identity tool was selected (or when the current
screen was "refreshed"), information regarding cartridge type, capacity, and write protect status
is shown here.

4. Click this button to display a list of media that is compatible with the product.

24 Basic Operation



Library and autoloader products
When a library or autoloader is selected in the Device List, the Device Information screen displays two
tabs: one for library information and one for the drives contained within the libraryFigure 5.

Figure 5 Device Information screen showing a library

1. This provides a visual representation of the selected product (the images are in grayscale).

2. As with a standalone drive, this area provides the relevant information on the selected library
product.

3. This provides a cartridge (media) inventory for all the drives and slots. The current status (full or
empty) of all the storage elements and the barcode number (if barcode reading is available) is
displayed here.

To see information for the drives within the library, select the Drive Information tab. This tab displays a
screen very similar to the one for standalone products, with the addition of the Selected Drive dropdown
menu.

Because a library can contain multiple drives, you can select and view information for each drive using
the Selected Drive dropdown menu. All of the drives in the library are available in the dropdown menu.
Selecting individual drives within a library from the By Product/By Connection device list displays the
drive as though it were a standalone product. The recommended method of diagnosing embedded drives
is to first select the library they belong to, and then select the specific drive within each tool window.

NOTE:
Selecting individual drives within a library from the By Product/By Connection device list displays the
drive as though it were a standalone product. The recommended method of diagnosing embedded drives
is to first select the library they belong to, and then select the specific drive within each tool window.

Using the Firmware Management screen
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The firmware management functionality of L&TT allows easy upgrades to the storage product firmware.
To access the Firmware Management screen, click the device you want to update in the device list, then
click the Firmware button on the main toolbar.

Figure 6 Firmware Management screen

For detailed information about the firmware management functionality of L&TT, see Firmware
Management.

Using the Tests screen

L&TT provides several standard and advanced tests that can be used to check the performance of or to
diagnose issues with storage hardware. To access the Tests screen, click the device you want to test in the
device list, then click the Tests button on the main toolbar.

Figure 7 Tests screen

For detailed information about the Tests screen, as well as information about how to perform the tests and
interpret test results, see Tests and Utility Functions.
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Using the Support Ticket Generation screen

L&TT can automatically generate a support ticket based on information that the program determines
about the system. The information in this support ticket can then be used to diagnose storage hardware
issues. L&TT can automatically e-mail the support ticket to the HP help desk to assist the help desk
technician in resolving issues.

To access the Support Ticket Generation screen, click the device you want to generate the support
ticket for in the device list, and then click the Support button on the main toolbar. Figure 8 shows the
Support Ticket Generation screen.

Figure 8 Support Ticket Generation screen

For detailed information about generating and using support tickets, see Support Ticket Generation.

Starting L&TT

To start L&TT:

• For HP-UX, Tru64, and Linux:
Log on as root and execute the following commands:
cd /opt/ltt
./hp_ltt

• For Novell NetWare
From the server console, execute the following command:
hp_ltt\hp_ltt

• For HP OpenVMS:
Run hp_ltt.exe found in the sys$sysdevice:[vms$common.opt.ltt] directory.
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When the CSI version of L&TT is started, the Scan Mode Selection screen is displayed.

Figure 9 Scan Mode Selection screen

When L&TT starts, it performs a device scan to identify all the devices connected to the computer, either
directly or through a SAN. In large SAN environments, this scan can take up to 45 minutes or longer.

The first time L&TT is run, it must perform a full hardware scan (Hardware Scan option), and the
Saved/Manual Scan option is disabled. The results of the full hardware scan are automatically saved, so
the next time L&TT is started, the Saved/Manual Scan option is available.

If you select Saved/Manual Scan, the Saved/Manual Scan screen is displayed.

Figure 10 Saved/Manual Scan screen (CSI)

Using the Saved/Manual Scan screen
The Saved/Manual Scan screen lets you select the devices that you want L&TT to scan and identify. This
can save time in a large SAN environment if you are using L&TT to test a single device. Any devices
that are not selected will not be scanned, and they will not be displayed in the Device List on the L&TT
Main screen.

The following command options are available:

• select—The indicated device or devices will be scanned.
• selectAll—All devices will be scanned.
• clear—The indicated device or devices will not be scanned.
• unselectAll—Clears all devices. No devices will be scanned.
• enterHWAddrManual—Lets you manually enter the hardware address of a device to be

scanned.
• hardwarescan—Performs a full hardware scan. Use this option to update the list of available

devices on the Saved/Manual Scan screen.
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• continue—Starts the indicated scan and proceeds to the Main screen.
• up—Exits the current command level.
• exit—Exits L&TT.

When the scan is complete, the Main screen is displayed.

Figure 11 CSI Main screen

Navigating the screens

The top line of each screen displays the current screen name in hierarchical format. Each “level” of
screens is separated by the “>” character. On each screen, some of the available commands take you
to a lower level in the hierarchy. To move back to the previous level, use the up command. To exit
L&TT, use the exit command.

On most of the screens, entering a blank command (pressing Enter without typing any other text) displays
a Command Help screen. This screen contains a list of valid commands that can be executed on the
original screen from which the Command Help screen was accessed. Figure 12 shows the Command
Help screen accessed from the Main screen.

Figure 12 Command Help screen accessed from the Main screen

It is possible to enter a command directly from the Command Help screen. To do this, type either the
number of the command or the name of the command and press Enter. Entering the number of the
command only works on the Command Help screen. From any other screen, you must type the full name
of the command. To exit the Command Help screen, enter a blank command (press Enter).

Some commands require an argument. For example, the select command requires a number that
corresponds to the device you want to select in the device list. To select the first device in the list, the
syntax is:
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select 1

If you enter a command with an invalid or missing argument, an error message is displayed.

Using the Device Information screen

When you first select a product from the Main screen, the Device Information screen is displayed,
showing information relevant to the device.

The main purpose of the Device Information screen is to provide an overview of the configuration and
status of the selected hardware device.

From the Main screen, type the following command to access the Device Information screen:

select <n> (where <n> is the number of the device to be examined)

NOTE:
Alternatively, you can omit the select command and only enter the device number.

Standalone devices
Figure 13 shows the Device Information screen for a standalone device.

Figure 13 Device Information screen for a standalone device

The following general information is displayed:

• Product ID (inquiry string)
• Drive technology
• Mech. serial # (drive serial number)
• Firmware revision
• SCSI target ID )
• SCSI LUN
• OBDR capability (if present)

If a data cartridge was inserted in the drive when the Device Information screen was displayed,
information regarding cartridge type, capacity, and write-protect status is shown.

To see a list of compatible media that can be used with this device, use the cartridge command.
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Library and autoloader products
Figure 14 shows the Device Information screen for a library.

Figure 14 Device Information screen for a library

NOTE:
Selecting individual drives within a library from the device list displays the drive as though it were a
standalone product. Embedded drives are best diagnosed by selecting the library they belong to, and
then selecting the specific drive within each tool window.

From the Device Information screen for a library device, use the cartridge command to display the
slot inventory of the library. The cartridge command shows which slots and drives currently have
cartridges loaded, and the cartridge barcode if available and applicable.
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4 Firmware Management

The Firmware Management functionality of L&TT provides a convenient way to easily upgrade the firmware
of connected devices. Library firmware and firmware of drives within the libraries can be upgraded as
well. In many cases, multiple drives within the library can be updated simultaneously to save time.

L&TT uses special firmware files that associate the firmware with a particular product. This feature prevents
the user from downloading the wrong image and ensures that the downloaded firmware is the same or a
newer revision than the current device firmware.

Click your operating environment:

Acquiring firmware files (GUI)

Acquiring firmware files (CSI)

Acquiring firmware files
L&TT firmware files are stored in the Firmware directory. This directory is a subdirectory of the
HP Library & Tape Tools installation directory. Before upgrading any firmware, you must first
acquire the firmware image file or files and copy them to the Firmware directory. Firmware files can
be obtained in three ways:

1. Select the device in the device listing and click the Firmware button on the main toolbar. On the
Firmware screen, click the Local Files tab, and then click the Get Files from Web button at the
bottom of the tab. The downloaded files are automatically placed in the Firmware directory.

2. From the L&TT menu bar, select Get Files From Web from the File menu. The software links to
the L&TT firmware ftp site and allows the selected firmware files to be copied to your system.
Downloaded files are automatically placed in the Firmware directory. This option is explained
in detail in the following section.

3. Go to http://www.hp.com/support, choose the product family, then click software updates
and drivers. The latest firmware file is available in L&TT format. For some products (such as
standalone drives), firmware is available as a single file. For other products (such as tape
libraries), the firmware is available in a self-extracting bundle that includes library and drive
firmware.

CAUTION:
Do not use the Get Files From Web functionality within L&TT without an Internet connection. Doing
so can cause the system to lock up until it has timed out in the operating system. This timeout value
is operating system-specific.

NOTE:
If Check for Updates on Web is enabled in the tool preferences, L&TT automatically informs the user
when new firmware is available for any of the connected storage products. L&TT performs this check
each time it is started (but not more than once per 24-hour period).

Using the Get Files from Web functionality (GUI)
The Windows version of L&TT offers comprehensive firmware management functionality that finds and
downloads firmware from the HP website. This functionality obtains the most up-to-date information
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about all available firmware files directly from the HP website. It then compares this data set against
the list of devices connected to the system and the current firmware revisions present in those devices.
Depending on the selected filter options on the top of the screen, different subsets of firmware files are
presented. Firmware files that are needed to bring the connected devices up to the latest firmware
revisions are automatically selected.

Accessing the Get Files from Web dialog box
You can access the Get Files from Web dialog box in two ways:

• Select Get Files from Web from the File menu
• Click the Get Firmware button on the Firmware Update screen

The Get Files from Web dialog box is displayed. Click the Firmware (New Files Available) tab if it is not
already selected. Figure 15 shows the Get Files from Web dialog box for firmware.

Figure 15 Get Files from Web dialog box—Firmware tab

Selecting and downloading updated firmware files
The Get Files from Web dialog box has four filter options:

• For devices on this system—These two options only show firmware files matching devices that are
currently connected to the system.
• Show latest firmware only shows the most recent firmware revision for each device.
• Show all firmware shows all firmware revisions for each of these firmware files.

• For all supported devices—These two options show firmware files for all devices supported by LTT,
even if not currently connected to the system.
• Show latest firmware only shows the most recent firmware revision for each device.
• Show all firmware shows all firmware revisions for each of these firmware files.

Select the appropriate option, and then verify that the correct firmware files are selected. To download
the selected files, click Download. The files are automatically downloaded to the current firmware
directory on the local system. You can now use the firmware update functionality of L&TT to upload the
latest firmware to your devices.
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Viewing firmware revision history
In addition to downloading firmware files, the Get Files from Web dialog box provides revision history
detail for firmware files. To view the firmware revision history of a device, select a device and click Details.

Uploading firmware to devices
Before attempting to update any firmware files, you must first acquire the latest firmware files and ensure
that they are placed in the Firmware directory. If you have not yet done this, see Acquiring firmware
files (GUI).

To upload firmware to a device:

1. Click the device to update in the device list.
2. Click the Firmware button on the main toolbar.
3. On the Update Firmware tab, click the checkbox to select each device for which you want to

update firmware. If firmware is currently available for that device, it is shown in the Firmware
File dropdown box in the File Selection section of the screen.

Figure 16 Firmware Update screen

With Windows NT and 9x versions of L&TT, you can select multiple devices and update them
simultaneously. With Windows 2000 and above, devices are updated sequentially. In Windows
NT and 9x configurations with multiple devices, the Force Sequential Updates checkbox gives
you the option to force sequential updates (this is only recommended if you have problems
updating devices simultaneously). With Windows 2000 and above, the Force Sequential
Updates checkbox is checked and cannot be changed.

4. Click the Start Update button at the bottom of the screen to begin the update.

CAUTION:
Make sure that no other programs attempt to access the device while the firmware is being updated.
Do not interrupt the firmware update. If the firmware update is interrupted, the device may not
operate and require physical repair.

L&TT creates a log of all firmware update activity. To view this log, click the Firmware Update Results tab.
Set the Current Detail Level setting to the appropriate level. The default is Normal. The firmware log is
displayed in a standard tree-view format. If you want to clear the log, click the Clear Log button.
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Advanced options
It is sometimes necessary to disable L&TT safeguards to perform more advanced operations. These
operations (options) are only available after the necessary password has been entered. To obtain this
password, contact HP support. After a password has been entered, the Options button on the Update
Firmware tab becomes available. When you click this button, the Factory Firmware Overrides dialog box
is displayed (this dialog box varies slightly between drives and libraries):

Figure 17 Factory Firmware Overrides dialog box

The Factory Firmware Overrides dialog box presents the following three options:

• Allow firmware downgrading—By default, L&TT does not show files with older revision levels as
selectable. On the Local Firmware Files tab, the comment field displays the message “downgrade
password required.” In most cases, you should use the latest firmware. However, if software
incompatibilities or other customer limitations require the use of older firmware revisions, this
checkbox lets you downgrade to older firmware revisions.

• Allow selection of any [drive or library] firmware file—This option allows mapping of the device
firmware to a product, irrespective of the device's product ID. There are a few cases in which the
product ID does not match the desired firmware file (and the ID may also need to be updated).
One case is when a library is being updated from one drive technology to another. Another case
is when the device has a firmware revision string format that differs from that in the firmware file,
and the tool cannot determine whether it is newer or older. If incompatible firmware is sent
to a device, an error message is displayed.

• Update [drive or library] product ID—This writes the product ID from the firmware file to the drive.

NOTE:
A number of products may not support updating the product ID, so use this feature only when you know
the device supports it. The most common use of this feature is when updating drive technologies in
optical libraries.

Acquiring firmware files (CSI)
L&TT firmware files are stored in the firmware directory, which is a subdirectory of the HP Library &
Tape Tools installation directory. Before upgrading any firmware, you must first acquire the firmware
image file or files and copy them to the firmware directory.

To download the latest firmware files:
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1. Go to http://www.hp.com/support, choose the product family, then click software updates
and drivers. The latest firmware file is available in L&TT format. For some products (such as
standalone drives), firmware is available as a single file. For other products (such as tape
libraries), the firmware is available in a self-extracting bundle that includes library and drive
firmware.

2. Download the file or files to the firmware directory.
3. If the downloaded files are self-extracting bundles, extract the contents to the firmware

directory.

Using the Get Files from Web functionality (CSI)
The CSI version of L&TT can also find and download firmware from the HP website. This functionality
obtains the most up-to-date information about all available firmware files directly from the HP website. It
then compares this data set against the list of devices connected to the system and the current firmware
revisions present in those devices.

To use the Get Files from Web functionality:

1. From the Main screen, enter the download command. The Download Tool screen displays a
list of download options.

2. Enter the number of the desired option. If a download option is selected, the Selector screen
displays a list of available firmware files to download.

3. Enter the number of the desired firmware file to download. The file is downloaded to the
firmware directory.

Uploading firmware to devices (CSI)
To upload firmware to one or more devices:

1. From the Main screen, type the number corresponding to the device to be updated and press
Enter to display the Device Information screen.

2. From the Device Information screen, enter the firmware command to display the Firmware
Update screen. Devices that are available for update are listed on this screen.

3. Type the corresponding number of the device you want to update and press Enter to mark the
device “selected.” If there are multiple devices, repeat this step for each device that you want
to update.

4. When all the required devices are selected, enter the start command to begin the update
process.

CAUTION:
Make sure that no other programs attempt to access the device while the firmware is being updated.
Do not interrupt the firmware update. If the firmware update is interrupted, the device may not operate
and require physical repair.

L&TT creates a log of all firmware update activity. To view this log, enter the review command from
the Firmware Update screen.

Advanced options (CSI)
Sometimes it is necessary to disable L&TT safeguards to perform more advanced operations. These
operations (options) are only available after the necessary password has been entered. To obtain this
password, contact HP support. To view the Options screen, from the Firmware Update screen, enter the
options command.

Before any of the options can be changed, the current password must be set. To set the password:
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1. Type the number that corresponds to the password option and press Enter. L&TT prompts you to
enter a value for “Current password entered.”

2. Type the password and press Enter. If the correct password is entered, the remaining options
on this screen become available.

NOTE:
All of the options are visible regardless of whether a proper password is entered or not. However, the
options are not available for selection without the proper password. After a proper password has
been entered, it is not required to re-enter it later.

The following options are available:

• Allow firmware downgrading—By default, L&TT does not allow firmware downgrading. In
most cases, you should use the latest firmware. However, if software incompatibilities or other
customer limitations require the use of older firmware revisions, this option lets you downgrade
to older firmware revisions.

• Allow any firmware file for [drives or libraries]—This option allows mapping of the device
firmware to a product irrespective of the device's product ID. There are a few cases in which the
product ID does not match the desired firmware file (and the ID may also need to be updated).
One case is when a library is being updated from one drive technology to another. Another case
is when the device has a firmware revision string format that differs from that in the firmware file,
and the tool cannot determine whether it is newer or older. If incompatible firmware is sent
to a device, an error message is displayed.

• Allow Product ID updates on [drives or libraries]—This writes the product ID from the firmware
file to the drive.

• Current password entered—This option lets you enter the factory password. The currently entered
password is displayed to the right of the option. If no password has been entered, Not Set is
displayed.

NOTE:
A number of products may not support updating the product ID, so use this feature only when you know
the device supports it. The most common use of this feature is when updating drive technologies in
optical libraries.
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5 Tests and Utility functions

L&TT provides numerous tests for analyzing storage hardware. These tests are grouped into two
categories: diagnostic tests and performance tests. The performance tests are hardcoded into the
program, but several of the diagnostic tests are SCSI script-based. A SCSI script is a sequence of SCSI
commands sent to a device, usually for the purpose of testing the device’s functionality. SCSI scripts can
also be used to perform non-diagnostic utility functions, such as rewinding a tape, recalibrating a tape
head, or “exercising” a tape-moving robot arm. A main advantage of SCSI script-based tests is that they
can be updated with new functionality and new tests can be added.

L&TT uses the following types of SCSI scripts:

• Script-based tests are tests based on scripts that are stored in the scripts directory in the L&TT
installation directory. The script-based test files have the *.tst extension.

• SCSI utility scripts provide access to generic SCSI operations. These scripts are accessed by
selecting Run Script... from the Utilities menu and have the *.scc extension. For more information,
see Using the utility functions (GUI).

NOTE:
Each script file contains information that tells L&TT which devices it is designed to support. When a
device is selected, the Tests screen displays only tests that are applicable to that particular device.

NOTE:
All scripts have a digital signature and cannot be altered. If they are altered in a text editor, L&TT
displays an error message stating that the digital signature is not correct.

Test descriptions
This section lists the available tests.

CAUTION:
Some tests are destructive to data on the media. When a test is destructive to data, this is indicated
in the test description. To prevent data loss, use media that is either new or that contains unimportant
data that can be erased. Do not attempt to perform a test unless you are thoroughly familiar with its
usage, or have been instructed to do so by HP support personnel.

NOTE:
Some tests listed here are documented in more detail in a separate section. If more information is
available, a hyperlink to that section is provided.

Performance tests
• Drive Performance Test writes data to a tape drive and calculates the performance of that drive

independently from the disk file system. Use this test in conjunction with the System Performance
Test to identify any system bottlenecks. Use a blank tape when performing this test because this
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test is destructive to data on the tape. The test can also measure tape drive read performance. This
test is available for all tape drives. For more information, see Using the Drive Performance Test.

• System Performance Test has two modes: The backup pre-test measures the read performance of
the disk file system (simulating a backup), and the restore pre-test measures the write performance
of the disk file system (simulating a restore). Use these tests in conjunction with the Drive
Performance Test to identify any system bottlenecks. The backup pre-test is read-only and is safe to
run on any part of your file system. The restore pre-test creates data in the specified directory
and can also be used to create test data for general backup testing. For more information, see
Using the System Performance Test.

• Connectivity Test examines the ability of the host to communicate with the device. This is a test
of the SCSI communication path only; no media is required. This option is useful when trying
to establish that the SCSI cables and adapters are working correctly. This test is available for
AIT, DLT, LTO, DDS, VS80, and VS160 drives.

• Device Self-Test executes the internal self-test of the device and reports any failures. This test
is useful in confirming that the device itself is operating properly. Not all devices support an
internal self-test.

• Device Analysis Test runs a device-specific script that carries out a detailed examination of the
device. The test examines all available logs from the device to look for any known issues,
customer use issues, and common error patterns. The test also provides summary information and
presents suggestions as to the cause of certain errors and any remedial actions the user should
take. This option is particularly useful if you suspect that there may be a problem with the device.
For more information, see Using the Device Analysis Test.

• Read/Write Test writes and reads data from tape and checks for accuracy. For more information,
see Using the Read/Write Test.

• Media Validation Test determines if the drive can read the data on any media currently in the
drive. The test is used to determine the quality of the media. The test reads data from the media
and calculates the error rate. If the error rate exceeds the maximum allowable threshold, the test
will require a cleaning cartridge and a second tape to determine if the problem is with the drive
or the tape. The amount of data read depends on the drive type and coverage level of the test,
but it generally varies between a few megabytes and one gigabyte. No data is written to tape
and the test is not destructive to data. This test is useful if the user suspects that a backup failed
because of a bad tape. This test is available for all tape drives.

NOTE:
This test requires that a minimum amount of data is already written on the tape, otherwise the test will
fail. This amount of data varies depending on drive technology and options.

NOTE:
For some devices, the Media Validation test has been superseded with the Media Analysis test.

• Library Exerciser Test takes a test cartridge from a mail slot and performs random slot-to-slot
moves. The test then moves the test cartridge into every available drive and performs a short drive
test. This test is intended to exercise the robotics and robot drive hardware. For more information,
see Using the Library Exerciser Test.

Diagnostic tests
• Data Compression Test writes a data pattern of known compressibility to tape. The test then

rewinds the tape and reads the file just written. The read and write hardware compression ratios
are calculated to ascertain that the hardware compression is enabled and working. If the script
finds that hardware compression has been disabled by the host or by switch configuration,
it reports this to the user. The compression ratios are displayed to the user and should be
approximately 2:1. This test is useful if tape capacity or hardware compression is in doubt. This
test is available for DLT, LTO, DDS, VS80, and VS160 drives.
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• DLT Firmware Tape Creator Test takes a firmware image and writes it to a tape cartridge for use as
a firmware update (FUP) tape. This test is available for DLT, DLT1, SDLT, VS80, and VS160 drives.

• DLT SRAM Check Tests (short and long versions) check drive logs for existing evidence of SRAM
chip corruption, and they perform a read/write test to check the drive for susceptibility to SRAM
corruption problems. The test is destructive to data on the cartridge in the drive. These tests
are only available for DLT drives.

• LTO Tape Stress Test performs a rigorous read/write test for the purpose of stress testing the
drive. This test is only available for LTO drives.

• LTO Firmware Tape Creator Test takes a firmware image and writes it to a tape cartridge for
use as a FUP tape.

• DDS Firmware Tape Creator Test takes a firmware image and writes it to a tape cartridge for use
as a FUP tape. The only DDS drives that can be updated using FUP tapes created with L&TT are
DAT72 drives and DDS4 drives that already have firmware version C305 or later.

• Initalize Element Status Test executes an initialize element status command on the library. This test
is available for all libraries.

• Full Sweep Test moves the robotics through the full range of motion to help prevent reliability
issues with the brush tracks. This test is available for the C7200 and C7145 library models.

• Restore Factory Settings checks the configuration parameters of the MO drive and identifies
configurations that differ from the factory default settings. If settings differ, the test can reset the
drive to the factory defaults. This test is only available for MO drives.

• LTO Cooling Check monitors the temperature sensors of an LTO drive while writing data to ensure
that the drive is cooling properly when installed in a server.

• LTO Stuck Tape Test tries to determine if the cartridge in the drive is physically stuck, or if it can
be unloaded and recovered. Run this test only if you suspect that the cartridge is stuck. This
test currently only supports standalone drives.

• DLT, DLT1, VS80, VS160, SDLT, LTO, and DDS/DAT Assessment Tests correlate with testing currently
done on returned drives. If the assessment test fails, this same drive would probably fail testing
within the return process. If the assessment test passes, this same drive would probably pass
testing within the return process. Correlation testing between these tests and the test used within
the return process has shown good results.
The assessment tests are available for the following drives:
• DLT Assessment Test: DLT4000, DLT7000, and DLT8000 drives
• DLT1 / VS80 / VS160 Assessment Test: DLT1, VS80 and VS160 drives
• SDLT Assessment Test: 110/220 and 160/320 SDLT drives
• LTO Assessment Test: LTO1 (Ultrium 215 and 230), LTO 2 (Ultrium 460) drives, and LTO3

drives
• DDS Assessment Test: DDS3, DDS4, DAT72 (pre- and post-merger HP drives only)

The DLT, DLT1, VS80, VS160, and SDLT assessment tests perform the following tests:
• SCSI interconnect test
• Review event log entries (which were present prior to running this test)
• Load the test tape
• Quick write/read test
• Soft unload/load test (DLT assessment test only)
• Minimum block size test
• Diagnostic self test (built-in drive function)
• Read/write tests, using various data patterns
• Bit error rate test
• Review new event log entries added during the test
• Unload the test tape

The LTO assessment test performs the following tests:
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• Initial preparation
• Review event log entries (which were present prior to running this test)
• SCSI parity check (LTO 1 drives only)
• Cartridge load
• Quick read/write test
• Cartridge unload
• SCSI parity check
• Review new events

The DDS assessment test performs the following tests:
• Review event log entries (which were present prior to running this test)
• Check life data in the serial EEPROM and the fault log
• Load check
• Perform a clean and write test
• Unload check
• MRS switch test
• Read check
• Review new events

• 1/8 Autoloader Assessment Test performs the following tests:
• Review robotics error log entries
• Run appropriate drive assessment test on the drive
• Check for new robotics error log entries
• Perform 12 to 24 drive loads and unloads (depending on drive type)
• Check for new robotics error log entries

• Media Erase Test converts a DDS or LTO data tape into a blank tape. This test has the following
three options:
• Quick erase—This option, which takes approximately one minute to complete, removes the

tape directory and writes EOD at the start of the tape, but it does not overwrite the data on
the remainder of the tape.

• Full erase—This option, which takes between two to four hours to complete, erases the tape
directory and also overwrites all data on the tape.

• Secure erase—This option, which takes between 10 to 20 hours to complete, performs a full
erase followed by a rewind. It repeats this four more times for a total of five full erases.

• ESL Vendor ID toggles the vendor ID between HP and COMPAQ on ESL libraries having firmware
revision 3.40 and later. This may be necessary because firmware revision 3.40 and later has a
vendor ID of HP, and there may be some applications that require the vendor ID to be COMPAQ.

• Media Analysis Test determines if the drive can read the data on any media currently in the
drive. The test is helpful in determining the quality of the media. However, the results are also
dependent on the drive's ability to read the media, and therefore the error rate measured is a
combination of the drive's ability to read and the quality of the media. If the drive's health is
not known, the Read/Write Test (used with known good media) can be used first. For more
information, see Using the Media Analysis Test.

• MO Media Validation Test validates magneto-optical (MO) media and reports any errors or
blank spaces present in the media, if any. This is a non-destructive test and is available for
all MO devices.

• SDLT Tape Edge Damage (TED) Test determines if any SDLT cartridges with tape edge damage
are present in an ESL9000 or MSL library. If the test passes, there are no tapes in the library
with TED symptoms. If it fails, evidence of tapes with TED has been found, and a message is
displayed indicating that the user should run the Read SDLT Media IDs test to locate the specific
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tapes with TED in the library. The message also instructs the user to contact HP support to identify
if any of the drives have the potential to cause tape edge damage, and to have them replaced
if any are identified.

• SDLT Read Media IDs Test loads each tape in the library into a drive and reads the media ID.
At the conclusion of the test, click the Test Results tab to see the media ID, slot number, and
barcode of each piece of media in the library. Normal usage for the Read SDLT Media IDs
test is in conjunction with the SDLT Tape Edge Damage Test to identify the location of tapes in
a library with tape edge damage.
This test assumes that the SDLT tapes have the proper barcode labels with “S” as the 7th
character, that the SDLT drives have the latest firmware, and that the library is configured to show
all barcode labels. Otherwise, the tapes may not be recognized with this test. If the Ignore
barcode labels when selecting tapes option is set to True, then the barcodes are ignored. If this
option is set to False, then the barcodes are required as described above. The default setting for
this option is False.
Additionally, the library must be configured to automatically unload the tape when it is being
moved from a drive. For MSL libraries, the Unload Mode option (under the Library Options
screen) must be set to implicit. For ESL9000 libraries, the Auto Drive Unload option (under
operator/configure options) must be enabled.

Using the Drive Performance Test
The Drive Performance test writes and reads data to/from the specified tape drive and calculates
performance data for that drive. The results of the test are shown on the Drive Performance Results
tab and also written to the event log.

To start the Drive Performance test (Windows version):

CAUTION:
This test is destructive to data on the tape. To avoid loss of data, use a blank tape when performing
this test.

NOTE:
The Drive Performance test is unavailable with ASPI I/O mode. You must use NT Miniport I/O mode to
perform this test.

1. In the device listing (either the By Product or By Connection tab), click the drive to test.

Library and Tape Tools User GuideProduct Version: 3.5 SR4 43



2. Click Dev Perf on the main toolbar. The Drive Performance screen is displayed and the Tape
Drive Performance tab is selected by default.

Figure 18 Drive Performance screen

3. In the Test Logic section of the screen, use the drop down boxes to select a data type for each
of the four tests. The Drive Performance test is actually a series of four write/read subtests
(labeled Step 1-4 on the Drive Performance screen) that measure performance using different
types of data that you can specify.
The following data types can be selected:
• Zeros
• 1.6:1 Compression
• 2:1 Compression
• 3:1 Compression
• 4:1 Compression
You must specify a data type for Step 1, but you can choose not to perform Steps 2 through
4 by selecting No Test in the corresponding dropdown box.

4. Specify the following additional parameters:
• Block Mode—choose one of the following:

• Fixed—the test uses a fixed block size (length) that can be specified in the Block Size
dropdown box.

• Variable—the test uses a different mode of data transfer. When this option is selected,
the Block Size dropdown box is disabled.

• Block Size—if Block Mode is set to Fixed, then specify the size of the data blocks used in
the test. Data blocks can be from 16K to 256K. This dropdown box is disabled if Block
Mode is set to Variable.

• I/O Size—the maximum amount of data to be transferred by a single read/write operation.
This length is typically a multiple of the Block Size and ranges from the specified Block
Size to 1MB.

• Test Size—the maximum amount of data written/read by the test. Valid choices range from
1GB to 15GB. Larger values increase the time required to perform the test, but they produce
more accurate test results.

• File Mark Mode—instructs the test to write a filemark at the specified interval (1MB to 1GB).
You can also instruct the test not to write any filemarks.

• Read After Write—when enabled, data is written to the tape and then the tape is read
back. When disabled, only write performance is measured. The test evaluates two sets of
metrics when enabled, and one when disabled.

• Rate Limiting—if rate limiting is enabled, the I/O rate is limited to the specified value.
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5. Click Start to perform the test. Progress of the test is displayed in the status bar to the right of the
Start button, and a dialog box will inform you when the test is complete.

6. Click the Drive Performance Results tab to view the results of the test. The results are also written
to the event log. See Using the event log for more information.

To start the Drive Performance test (CSI version):

1. Use the select command to select the device to be tested.
select <n> (where <n> is the number of the device to be examined)

NOTE:
The devperf command is not available until a device is selected.

2. From the Main screen, enter the devperf command to display the Device Performance Tool
screen. The Device Performance Tool screen displays several test options with their default
settings.

Figure 19 Device Performance Tool screen

3. If necessary, change the settings for one or more options. To change the settings, enter the
number that corresponds with the option that you want to change. Enter the new value at the
prompt. The five available options for this test are:
• Blocksize—specify the blocksize, in bytes, to be written to the tape. Typical values are 32768

(32KB), 65536 (64KB). The default is 65536.
• Repetitions—specify how many write/read operations to perform. The default is 4096.
• Readback—specify whether to enable the readback test after writing data to the device.

This option measures read performance in addition to write performance in MB/sec. This
option is disabled by default.

• Count—specify how many blocks to write to the tape device per write operation. The
default is 16.

• Pattern—specify the data pattern to be written to tape. Enter 2 for 2:1 compression ratio or
3 for 3.1:1 compression ratio. The default is 2.

4. Use the start command to start the test.

Using the System Performance Test
The System Performance test writes and reads data to/from the specified directory and calculates
performance data for the backup server. The Restore Pre-Test (write) and Backup Pre-Test (read) portions
of the tests are actually separate tests and are executed separately.
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Performing the System Performance Restore Pre-Test (GUI)
1. Click Sys Perf on the main toolbar. The System Performance screen is displayed.
2. Click the Restore Pre-Test tab.

Figure 20 Restore Pre-Test tab of the System Performance screen

3. Specify the following parameters:
• Test Path—enter the destination directory (or use the Browse button to browse to the directory)

that the test will write data to. This should be a directory on the backup server being tested.
• Test Data Type—select the type of data pattern to be written. Choose from the following

options:
• Fixed Byte
• Incrementing
• Random
• Uncompressible Data
• 2:1 Compression Ratio
• 3:1 Compression Ratio
• 4:1 Compression Ratio

• File Size—use the two dropdown boxes to specify a range of possible file sizes for the
test data.

• File Tree Depth—specify the number of levels of subdirectories the program will create from
the specified directory.

• File Tree Breadth—specify the number of directories to be created within each subdirectory.
• Files Per Directory—specify the number of files to be created within each subdirectory.

NOTE:
The gauges in the Disc Capacity section of the screen show the amount of disk space required for
the System Performance test using the current settings, and the amount of space available in the
indicated filesystem. If the required space exceeds the available space, the Test Size gauge displays
OVERFLOW, and you will be unable to start the test.

4. Click Start to perform the test. Progress of the test is displayed in the status bar to the right of the
Start button, and a dialog box will inform you when the test is complete.

5. Click the System Performance Results tab to view the test results. The test results are also written
to the event log. See Using the event log for more information.
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Performing the System Performance Backup Pre-Test
This test reads data from up to four separate locations on the file system. The reads are concurrent and
simulate up to four concurrent backup data streams. The performance of these reads is measured and
reported in the System Performance Results tab. Use this test to measure the performance of the file system
to be used for backup. Use this test in conjunction with the Drive Performance Test to identify performance
bottlenecks in the system. This test is read-only and can be safely run on backup source data.

1. Click Sys Perf on the main toolbar. The System Performance screen is displayed.
2. Click the Backup Pre-Test tab.

Figure 21 Backup Pre-Test tab of the System Performance screen

3. Specify the following parameters:
• Read Size—enter the maximum block size (in bytes) to transfer.
• Directory Traverse Method—specify one of the following options:

• Specify Depth to have the test read as far down the directory structure as possible before
moving laterally to the next directory.

• Specify Breadth to read all directories at the same level before moving down to the
next subdirectory level.

• Stop After—specify a time limit for the test, or select “All Readers Complete” to continue
testing until the test is complete.

• Reader [1-4]—enter up to four target directories (use the Browse>>> button to browse to
each directory) that the test will read data from. For each Reader, you must have first
performed a Restore Pre-Test. Use the same directory or directories that you specified
in the Restore Pre-Test(s).

• Read Files—specifies whether the files must be read back from the tape after the write
completes.

4. Click Start to perform the test. A dialog box will inform you when the test is complete.
5. Click the System Performance Results tab to view the test results. The test results are also written

to the event log. See Using the event log for more information.

Performing the System Performance Pre-Tests (CSI)
To start the CSI version of the System Performance Pre-Test:
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NOTE:
The System Performance Pre-Tests (backup and restore) are not available for NetWare.

1. From the Main screen, enter the sysperf command to display the System Performance screen:
2. Enter one of the following commands (depending on which pre-test you want to run):

• backup—runs the Backup Pre-Test
• restore—runs the Restore Pre-Test

3. If necessary, change the settings for one or more options. To change the settings, enter the
number that corresponds with the option that you want to change. Enter the new value at
the prompt.
Figure 22 shows the Backup Pre-Test screen.

Figure 22 Backup Pre-Test screen (CSI)

The two options available for the Backup Pre-Test are:
• Blocksize—specify the blocksize, in bytes, to be read. Typical values are 32768 (32KB),

65536 (64KB). The default is 65536.
• Path—specify the path to the directory to be read from.
Figure 23 shows the Restore Pre-Test screen.

Figure 23 Restore Pre-Test screen (CSI)

The following options are available for the Restore Pre-Test:
• Filesize—specify the size, in bytes, of the test files to be created.
• Number of Files—specify the number of files to be created.
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• Directory path—specify the path of the directory where the test files will be written.
• Pattern—specify one of the following data patterns:

• Fixed byte
• Incrementing byte
• Random data
• 1.6:1 compressible data
• 2:1 compressible data
• 3.1:1 compressible data
• 4.3:1 compressible data

4. Use the start command to start the test.

Using the Device Analysis Test
The Device Analysis test can be executed manually through the Tests screen or automatically whenever
a support ticket is generated. The Device Analysis test is unique among all the tests offered by L&TT.
In addition to performing SCSI operations directly on a device, the Device Analysis test uses a set
of predefined, device-specific rules to analyze device logs and configurations. If any known issues
are discovered during the analysis, the user is notified of the problem and the program suggests an
appropriate course of action.

The Device Analysis test automates failure analysis of a device by determining whether a known or
unknown problem with a device exists, if the problem can be resolved in the field through maintenance or
simple repair, and whether a device needs to be returned or serviced.

Using the Read/Write Test
The Read/Write test writes and reads data from tape and checks for accuracy. In addition to verifying
that the data read back matches the data written, the read/write error rates are also checked. The test
fails if the error rates exceed allowable limits. This test can be used to verify the ability of the drive to
read and write data independent of the storage application. This test is available for all tape drives.

CAUTION:
Use a blank tape when performing this test because this test is destructive to data on the tape.

The following options are available for this test:

• Test Time Limit—specify the time limit in minutes. Enter 0 for no time limit.
• Data Limit Type—specify one of the following options to limit the amount of data written/read

in each phase:
• Time—limits the amount of data tested based on the time specified in Data Time Limit.
• Size—limits the amount of data tested based on the size specified in Data Size Limit.
• Whole tape—limits the amount of data tested based on the size of the tape.

• Data Size Limit—specify the size limit in megabytes of data to be written/read in each phase.
• Data Time Limit—specify the time limit, in minutes, for each phase of the test.
• Block Size—specify the block size, in kilobytes, to be used in the test.
• Transfer Size Limit—specify the maximum data transfer limit, in kilobytes, per command.
• Block Transfer Type—specify whether to use a fixed or variable block length.
• Data Pattern Type—indicates the type of data pattern used in the test. Specify one of the

following data pattern types:
• Pattern File—uses a preset pattern
• Random—generates random patterns
• User defined—uses a user-defined string
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• Data Pattern—specify a string value to use as a data pattern if the Data Pattern Type is set to
“User Defined.”

Using the Media Analysis Test
The Media Analysis test reads data from the media and calculates the error rate. If the error rate
exceeds the maximum allowable threshold, the test will require a cleaning cartridge and a second tape
to determine if the problem is with the drive or the tape. No data is written to tape and the test is not
destructive to data. This test is useful if the user suspects that a backup failed because of a bad tape.
This test is available for all tape drives.

The following options are available for this test:

• Test Time Limit—specify the time limit in minutes. Enter 0 for no time limit.
• Data Limit Type—specify one of the following options to limit the amount of data read in each

phase:
• Time—limits the amount of data read based on the time specified in Data Time Limit.
• Size—limits the amount of data read based on the size specified in Data Size Limit.
• Whole tape—limits the amount of data read based on the size of the tape.

• Amount of data read in each phase—specify the size limit in megabytes of data to be read
in each phase.

• Time allowed for each data test phase—specify the time limit, in minutes, for each phase of
the test.

• Transfer Size Limit—specify the maximum data transfer limit, in kilobytes, per command.

Using the Library Exerciser Test
The Library Exerciser test takes a test cartridge from a mail slot and performs random slot-to-slot moves.
The test then moves the test cartridge into every available drive and performs a short drive test. This test is
intended to exercise the robotics and robot drive hardware.

The following options are available for this test:

• Test Time Limit—specify the time limit in minutes. Enter 0 for no time limit. The default setting is 0.
• Move Command Timeout—specify the maximum time alloted, in seconds, for each move

command before failure. The default is 600 seconds.
• Active Slot Range—specify a range of slots to be tested. Enter a range of slot numbers separated

with a dash (for example: 2-5), or enter all to specify all slots. The default is “all.”
• Active Drive Range—specify a range of drives to be tested. Enter a range of drives separated

with a dash (for example: 2-5), or enter all to specify all drives. The default is “all.”
• Drive Type Option—specify the type of drives to be tested (in libraries that have mixed drive

types). Enter the type of drive (for example: LTO or DLT), or enter all to test all drive types. The
default is “all.”

• Check Inventory Mode—specify whether to perform an active inventory check at beginning of the
test. The active inventory check can take a long time to perform. The default is “on.”

• Barcode Mode—specify how barcodes are handled. Choose one of the following options:
• Show all—shows all barcodes
• Show suspect—shows only suspect barcodes (default)
• Off—does not show barcodes

• Slot-to-Slot Moves—select one of the following options for the slot-to-slot test:
• All—moves all cartridges
• Random—moves randomly selected cartridges (default)
• Off—no cartridges are moved

• Random Coverage—when Slot-to-Slot Moves is set to “Random,” specify the percentage of units
covered during random test. The default is 20%.
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• Drive Load Test—specify whether or not to perform the Drive Load test. The default setting is “on.”
• Drive Test Option—if the Drive Load test is enabled, specify one of the following options:

• Off
• Data loop back (default)
• Read-only
• Read/write

• Cartridge Load Test—specify one of the following options for the Cartridge Load test:
• Off (default)
• Single drive
• Multiple drives
• All drives

• CM Integrity Test—specify whether to enable the CM integrity check option for LTO drives. The
default setting is “on.”

Running the tests (GUI environment)
To select and run a test manually:

1. In the device listing (either the By Product or By Connection tab), click the device to test.
2. Click Test on the main toolbar. The Tests screen is displayed and the Test Execution tab is

selected by default.
3. Click the checkbox to the left of the device name that you want to test. The Test Group dropdown

box is enabled, listing all the tests available for the selected device.
4. In the Test Group dropdown box, select the test to perform. A description of the selected test is

displayed in the Description text box.
5. If any options are available for the selected test, the Options button is enabled. Click the Options

button to review and set the desired options.
6. Click the Start Test button to start the test.

Viewing test results
After the test has completed, click the Test Results tab to view the results. The results of the test are
displayed in the Test text box. A more detailed Test Operation Log is displayed in the bottom section of
the screen. The information is presented as a report in a standard tree-view format. Click the “+” or “–”
signs to expand or collapse a section of the report. Select an option in the Current Detail Level dropdown
box to display more or less information in the Test Operation Log.

Running the tests (CSI environment)
To select and run a test manually:

1. On the Main screen, enter the number corresponding to the device that you want to test. The
Device Information screen is displayed.

2. On the Device Information screen, enter the test command. The Test screen is displayed. The
Test screen displays the currently selected test and lists the available devices to be tested.

3. To select a different test, enter the picktest command. On the Selector screen, enter the
number of the test you want to perform. The Test screen is redisplayed and the currently selected
test is updated.

4. To select or deselect devices to be tested, enter the corresponding device number to toggle the
selected status of the device. To deselect all devices, enter the clear command.

5. Enter the start command to start the test.
6. When the test is complete, a dialog is displayed showing preliminary results of the test. Press

any key to return to the Test screen.

Library and Tape Tools User GuideProduct Version: 3.5 SR4 51



Viewing test results (CSI)
To view detailed test results, enter the review command. Test results are displayed in a hierarchichal
format.

Use the detail command without any arguments to view the current detail level of the report. Use the
detail command with a numeric argument to set the detail level. The available detail level arguments
are as follows:

• 1 — highlights only
• 2 — normal
• 3 — more details
• 4 — everything
• 5 — factory only (requires a factory password. To enter a password, use the options command.)

If necessary, use Ctrl+U and Ctrl+D to scroll up and down through the results. Use the find and page
commands to quickly locate information in the report.

Using the utility functions
Utility functions execute the SCSI utility scripts (files with a *.scc extension) stored in the scripts
directory. These scripts send various SCSI commands to the selected device, but they generally do
not return any results.

Many of the utility functions are device-specific and intended only to remedy specific problems that may
occur with a particular device.

CAUTION:
Using a script improperly or when it is not required can cause more harm than good—possibly
rendering a device inoperable. Do not attempt to use these utility functions unless you are very familiar
with SCSI operation, or you have been advised to do so by a technical support representative or a
Device Analysis script.

To use a utility function with the Windows version of L&TT:

1. Select Run Script... from the Utilities menu to display the Run Script dialog.
2. In the Devices section, click the checkbox next to the device on which the script will be run.
3. Click Browse to select a script file to execute. The utility scripts are located in the scripts

directory and have a *.scc extension. Select a script and click Open to return to the Run Script
dialog.

4. Click Run Script at the bottom of the dialog box to run the script. When the script has completed,
relevant information is displayed in the Script Output and Script Execution Log text boxes.

To use a utility function from the CSI:

1. On the Main screen, enter the number corresponding to the device that you want to test. The
Device Information screen is displayed.

2. Enter the runscript command.
3. Enter 1 to specify the script path.
4. Enter the path, including the filename of the script. The utility scripts are located in the scripts

directory and have a *.scc extension.
5. Enter the start command to execute the script.
6. Enter any additional information required by the script.
7. Use the up or exit commands as necessary to exit the tool when the test is complete.
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6 Support Ticket Generation

A major feature of L&TT is the ability to generate a support ticket. In the event of a hardware problem, a
support ticket can provide vital information to help in diagnosing and resolving the problem.

When a support ticket is generated, L&TT collects configuration information and executes a Device
Analysis test on the selected device. This information can then be viewed, saved, printed, compared to
another support ticket, or e-mailed. A support ticket is saved as a log file having the *.ltt extension. By
default, log files are saved to the log directory.

The support ticket viewer is built into the L&TT application. The viewer enables viewing of detailed device
information and general information on the system it is connected to. This information is displayed in a
standard treeview format. The user (or support technician) can change the detail level of the support
ticket, browse through the support ticket information, and expand or collapse specific sections of the
support ticket as required.

NOTE:
Regardless of the selected detail level, the log file always contains all of the information collected from the
product. The support ticket viewer filters this information, depending on the detail level.

L&TT support tickets are saved in a proprietary format and therefore require the support ticket viewer.
However, with the Windows version of L&TT, a support ticket can be converted to HTML format using
the currently selected detail level. The HTML version can easily be printed or viewed by other users
without the support ticket viewer.

NOTE:
After an HTML support ticket has been generated, the detail level within the HTML file cannot be
changed. Make sure that the detail level is set to the desired level before generating the HTML report.

NOTE:
In the Windows version of L&TT, right-clicking on any of the text in the support ticket viewer displays a
context menu with more options. A quick way to see the entire support ticket is to set the detail level to
everything or factory only, right-click the top support ticket entry, then select Expand All.

Generating and viewing a support ticket
To open the Support screen:

1. Click a device in the device list (By Product or By Connection tab) to select it.
2. Click the Support button on the main toolbar to display the Support screen.

The bottom section of the screen provides resources for finding support on the Web. Clicking any of
the buttons in the Support Resources on the Web section of the screen opens a browser window to
display the corresponding web site.

Generating a support ticket
The Support screen presents three options for generating a support ticket. Each of the following three
options has a corresponding button in the Generate Support Ticket section of the screen.
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• View Support Ticket—Click this button to generate the support ticket and immediately view it in
the support ticket viewer. The support ticket can later be saved or sent via e-mail. For more
information, see Viewing a support ticket.

• Save Support Ticket to File—Click this button to generate and save the support ticket. The support
ticket is saved as a log file with the *.ltt extension. Large support tickets are broken up into
multiple log files. The support ticket can later be viewed or sent via e-mail. To view a saved
support ticket, open it through Windows Explorer, or use the Load command on the File menu.

• Send Support Ticket by E-mail—Click this button to generate the support ticket and immediately
send it via e-mail to an HP support center (or other destination). Clicking this button opens a form
that allows you to provide all the necessary information. Complete the form and click the Send
button to send the e-mail. Using this option does not save a copy of the support ticket locally, so
you are advised to click Save Support Ticket to File to save a copy for future reference. For more
information, see Sending a support ticket by e-mail.

NOTE:
When sending a support ticket by e-mail, L&TT provides the option to compress the support ticket.

Viewing a support ticket
After a support ticket is generated, it is displayed in the support ticket viewer. This viewer is built into
the L&TT program. Information is displayed in a standard tree-view format. Click the “+” and “–” signs
to expand and collapse sections of the support ticket. Use the standard navigation keys (Home, End,
Page Up, Page Down, and the arrow keys), the Windows scroll bars, and the mouse to navigate
through the document.

To print the support ticket, select File > Print from the menu bar within the support ticket viewer.

Setting the detail level
The support ticket can display information in several different levels of detail, depending on the setting
displayed in the Current Detail Level dropdown box. The following detail level settings are available:

• Highlights only
• Normal
• More detail
• Everything (the highest level the end user can view)
• Factory only (requires a factory password. Contact HP support to obtain a factory password)
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NOTE:
The “factory only” detail level is only visible after the factory password has been entered into the
software, either from the menu function in the report viewer or in the menu item within the main
application. If the factory password is entered via the main application, it is saved in the registry and
will not require subsequent re-entry.

Figure 24 Example support ticket with normal detail (Windows version)

Using the Tabular View
Tabular View is available only when the detail level is set to “factory only.” Items in the support ticket that
are preceded with the Tabular View icon ( ) have additional information that can be displayed in
Tabular View. To view the additional information in Tabular View, click the icon. One of the following
occurs:

• If only one view is available for the item you clicked, then a Tabular View window immediately
opens.
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• If more than one view is available for the item you clicked, a shortcut menu is displayed. Select
the desired option and click OK. The Tabular View window opens.

Figure 25 Tabular View window

The Tabular View window supports the following operations:

• Sorting columns—Click a column header to sort by that column. Repeatedly clicking the same
column header toggles between ascending and descending sort order.

• Filtering columns—Right-click a column header and choose Filter from the context menu to filter a
column. A dialog box prompts you for the filter value. Enter a value and click Filter. To remove
the filter, right-click the column header again and choose Clear Filter from the context menu.

• Exporting data—The Tabular View data can be exported as a CSV (comma separated value)
file. A CSV file is a text file in which values are separated by a comma (or other specified
separator). Data in a CSV file can be imported by a variety of popular spreadsheet and database
applications such as Microsoft Excel and Access.
To export Tabular View data to a CSV file, choose Export from the File menu. Enter the path and
filename for the CSV file in the dialog box and click Save.

Other support ticket functionality
Right-click any node (line) in the support ticket viewer to display a context menu that exposes additional
functionality. Depending on the node that was clicked, the following items may or not be available
(unavailable items are greyed out):

• Expand All—Selecting this item expands all subitems in the node.
• Event Explanation—Selecting this item opens the Event window that displays additional

information about the event. You can view the the data in either ASCII or hexadecimal format.
This feature is available for items preceded with the blue information icon ( ).

• Event Data—Selecting this item opens the Event Data window that displays L&TT-specific
information about the event.

• Copy—Selecting this item copies the current line to the Windows clipboard.
• Reference Data—Selecting this item opens the Reference Data window that displays reference

information pertinent to the current line such as valid ranges and applicable values.
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Sending a support ticket by e-mail
From the Support screen, click Send Support Ticket by E-mail to generate the support ticket and
immediately send it via e-mail to an HP support center (or other destination). When you click Send
Support Ticket by E-mail, the E-mail Support Ticket dialog box is displayed.

Figure 26 E-mail support ticket dialog box

Before L&TT can email a support ticket, you must either have a MAPI-compliant e-mail program (such
as Microsoft Outlook or Outlook Express), or you must set up an email account through the Windows
Control Panel or Internet Explorer. For more information about setting up an e-mail account, see How do I
configure e-mail to send support tickets

The E-mail Support Ticket dialog box is divided into three steps:

1. In Step 1, indicate whether this is a new support request or an existing case.
• If this is a new support request, select the Send to support provider to request support by

e-mail option (this option is the default). Enter the product number and product serial number
in the appropriate fields.

• If this is an ongoing support case, select the Send to support provider in reference to an open
case option and enter the case reference number in the appropriate field.
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2. In Step 2, enter the destination e-mail address. Use the dropdown box to select from a list of
HP support providers, or enter the e-mail address manually.

3. In Step 3, specify the following additional information:
• Contact information—Enter your company name, contact name, contact phone, and contact

e-mail address.
• Attach Result Log—Select this option to attach the support ticket to the e-mail for analysis

by HP service personnel.
• Attach additional Event Log (only if requested)—Select this option if you have been requested

by HP service personnel to send the event log. For more information about using the event
log, see Using the event log.

• Compress the support ticket—Select this option to compress the support ticket. This option is
selected by default.

• Problem description—Enter a detailed description of the problem you are having.

When you have completed the form, click Send.

NOTE:
Large support tickets are automatically broken down into multiple, smaller sub-ticket components and sent
in multiple emails. The master file has an .ltt extension, and the sub components have a .dat extension.
To be viewed properly, the recipient of these emails must save all of the sub-ticket components to the
same directory. When sending a large support ticket by email, be sure to send all of the components or
else the support ticket will be unreadable.

Comparing support tickets
L&TT can compare two support tickets and generate a report of the differences. To compare two support
tickets:

1. Generate or open the first support ticket to be compared.
2. In the support ticket viewer, select File > Compare. The Open dialog box is displayed.
3. Select the support ticket to which you want to compare and click Open. The comparison results

are displayed in a separate window as shown in Figure 27.

Figure 27 Support ticket comparison results

Generating and viewing a support ticket (CSI)
To generate and view a support ticket in the CSI environment:

58 Support Ticket Generation



1. From the Main screen, select the device for which to create a support ticket. The Device
Information screen is displayed.

2. Enter the support command to access the Support screen.
3. From the Support screen, do one of the following:

• Enter the view command to view the support ticket.
• Enter the save <filename> command to save the support ticket with the specified filename.

The support ticket can be viewed later using the load command from the Main screen.
• Enter the send command to send the support ticket by e-mail. See Sending a support ticket

by e-mail (CSI) for more information.

When viewing the support ticket, use Ctrl+U and Ctrl +D to scroll up and down through the results. You
can also use the find and page commands to quickly locate information.

Sending a support ticket by e-mail (CSI)
To generate a support ticket and send it via e-mail:

1. From the Main screen, select the device for which to create a support ticket. The Device
Information screen is displayed.

2. Enter the support command to access the Support screen.
3. From the Support screen, enter the send command to display the Send Support Ticket screen.

The Send Support Ticket screen displays a list of several parameters that must be entered before
the support ticket can be sent. The screen displays the current values for each parameter.

4. Enter the number of the first parameter, and then enter the parameter data at the prompt.
5. Repeat step 4 for each remaining parameter and option.
6. When all the required parameters and options have been specified, enter the send command

to generate and send the support ticket.

Common information reported for all products

NOTE:
For standalone devices (such as DDS drives), HP recommends that you generate the support ticket when
the drive still contains the media with which the drive may have failed. This allows error rate and
other information relevant to that cartridge to be examined. When media is removed, many products
automatically clear this information. However, for most SureStore tape libraries it is better to have the
drives empty; this forces the library drive/media log to be updated.

The following information is included in the support ticket regardless of what products are being analyzed:

• System information provides basic host system information such as operating system, processor
type, system name, physical memory size, and the current version of L&TT being used. This
information also includes a snapshot of the SCSI bus configuration determined by the I/O scan,
showing connected devices listed physically and logically.

• L&TT history provides a brief history of the L&TT functions the user has accessed such as whether
ASPI was installed, how many times L&TT has been run, and which functions have been used.

Device-specific information reported
The support ticket also contains device-specific information that varies by device family.
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Using the event log
L&TT can generate a detailed event log that captures all L&TT diagnostic interaction with the product, all
SCSI commands sent and received by the program, and any software interactions or issues. By default,
the event log is not accessible until the factory password has been entered. The information it contains is
intended for use by L&TT programmers as a tool for debugging software issues within the program itself.

If you experience a software problem with L&TT:

1. Run L&TT and select Preferences from the Options menu.
2. Check the Add I/O history to event log option and click OK.
3. Exit and restart L&TT.
4. Replicate the problem encountered.
5. Using Windows Explorer, navigate to the logs directory in the L&TT installation directory.

Locate the Eventlog.ltt file.
6. Attach the Eventlog.ltt file to an e-mail and send it to the L&TT team for diagnosis.
7. Return to L&TT and select Preferences from the Options menu.
8. Uncheck the Add I/O history to event log option and click OK. This option should not be left

enabled because it can potentially use hundreds of megabytes of disk space.

NOTE:
In the log directory you may also see other event log entries such as EventLog_backup1.ltt,
EventLog_backup2.ltt, EventLog_backup3.ltt, and so on. The versions of the event log are numbered in
historical order.
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7 Additional Functionality

This chapter describes additional features of the program that are not covered elsewhere in this guide.

• Setting software preferences
• Using the Internet update functionality
• Using passwords
• Using the Front Panel function
• Using the Move Media function
• Performing manual product identification
• Using the Quiet Mode feature
• Using the Installation Check feature
• Using L&TT in restricted mode
• Using the Tool Status Report

Setting software preferences
L&TT has many user-definable preferences that control various elements of the program. To access
the L&TT preferences:

To set the preferences in the Windows version of L&TT, select Preferences from the Options menu.
The preferences dialog is displayed as shown in Figure 28.

Figure 28 L&TT Preferences dialog box (default settings shown)
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To set the preferences in the CSI version of L&TT, from the Main screen, use the preferences
command to display the Preferences screen.

Figure 29 L&TT preferences dialog box (CSI version)

Available options
The following list describes the available options. Some options are not available with CSI versions of
L&TT.

• Show Scan Details (Windows only)—Enabling this option causes L&TT to show the SCSI bus
scanning process in the Device List screen when the program is first started. This option is
disabled by default.

• Show Instructions (Windows only)—Enabling this option causes L&TT to display instructions in the
Device List screen. These instructions provide information corresponding to the function displayed
in the Main screen. More experienced users may want to disable this option.

• Firmware File Path—This is the location where L&TT stores and accesses firmware files on your
local system. When using the “Get Firmware From Web” feature, firmware files are automatically
downloaded to this directory.

• Log File Path—This is the location where L&TT stores and accesses log files on your local system.
The logs that are stored here are the support and event logs.

• Script File Path—This is the location where L&TT stores and accesses device analysis rules files.
This is also the default location for SCSI scripts.

NOTE:
For all of the previous three options, the default location of the directory is the L&TT Installation
directory.

• Display splash screen at startup (Windows only)—Enabling this option causes the L&TT splash
screen to be displayed when the program is started. From the splash screen, you can select
the I/O mode and other options.

• Check for updates on the Web (Windows only)—When this option is enabled, L&TT uses an
available Internet connection to look for product updates such as firmware upgrades, new device
analysis rules, and new versions of L&TT. The software performs this check once every 24 hours.
This functionality is only available if you have an Internet connection. For more information, see
Using the Internet update functionality later in this chapter.

• Display dialogs for I/O pending more than 2 minutes (Windows only)—When this option is
enabled, L&TT displays a status update dialog box during long SCSI operations.

• Add I/O history to Event Log—Enabling this option causes L&TT to log all SCSI commands that
are sent or received into a log file.This option requires a large amount of disk space and should
only be used when requested by L&TT development personnel to aid in the debugging of a
potential issue with L&TT. For more information, see Using the event log.
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• Data Phase Limit for I/O History—When the Add I/O History to Event Log option is enabled, this
option limits the amount of data recorded to the log file for each SCSI command to the number of
bytes specified. The default is 128 bytes. To specify a data phase limit, enter any positive number
in this field. If you do not want to specify a limit, enter unlimited.

• Current password entered—This option lets you enter the factory password. The currently entered
password is displayed to the right of the option. If no password has been entered, Not Set is
displayed.

• Enter Maximum E-Mail size—This option lets you specify a maximum size (in megabytes) for
support tickets. If the support ticket exceeds this size, it will be broken up into smaller subtickets.

Using the Internet update functionality
The Windows version of L&TT can automatically notify the user of the following conditions each time
the program is started:

• A new version of L&TT has been released
• A new version of firmware is available for a connected storage device
• A new version of device analysis rules is available for a connected storage device

This notification only occurs if the user has the Check for updates on web option enabled in the
preferences dialog (this option is enabled by default).

If the Check for updates on web option is not enabled, select Get Files from Web from the File menu
to manually check for and download updates.

NOTE:
L&TT will only check for updates on the Web once in a 24-hour period.

Using passwords
A number of tool features are available only when enabled with a password. The password is intended
to prevent inexperienced users from accessing functionality that may be particularly harmful to their
system if used improperly.

Setting passwords

To set the password in the Windows version of L&TT:

1. Select Enable Factory Overrides from the Options menu. The Factory Password dialog box is
displayed.

2. Enter the password and click OK. Assuming the password is valid, you are now able to access
the password-protected functions of L&TT.

To set the password in the CSI version of L&TT:

1. From the Main screen, enter the preferences command. The Preferences screen is displayed.
2. Enter the number that corresponds to the password option. L&TT prompts you for the current

password.
3. Enter the password. If the password is valid, then L&TT returns you to the Preferences screen.

You are now able to access the password-protected functions of L&TT.

Using the Front Panel function
L&TT provides remote control of the front panel of selected library devices. L&TT reads the contents of the
front panel at regular intervals and displays the contents of the L&TT window either in graphic or text
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form. In addition, L&TT displays a representation of the library’s front panel buttons. Clicking a button
simulates the user pressing the corresponding button on the library's front panel.

To access this functionality, select the library in the device list and click Frontpanel on the main toolbar.
The Front Panel screen is displayed as shown in Figure 30.

Figure 30 Front panel screen

Using the Move Media function
Most supported libraries and autoloaders support a set of commands for moving media from one
location to another within the device. Whenever possible, L&TT takes advantage of this functionality to
provide a convenient way to move media within a library or autoloader. This functionality is supported in
both the GUI and CSI versions of L&TT.

With the Windows version of L&TT, the Move Media functionality is incorporated into the Front
Panel screen. To access this functionality:

1. Select a supported library or autoloader from the device list and click Frontpanel on the main
toolbar (the Frontpanel button is grayed out if both the Move Media and Front Panel functions
are not supported for the selected device).
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2. On the Front Panel screen, click the Move Media tab (this tab is not available if the Move Media
function is not supported for the selected device). The Move Media screen is displayed.

Figure 31 Move Media screen

The Move Media screen is divided into two sections showing all available source and destination drives,
slots, and mailslots. To move media from one location to another, selected the desired source and
destination locations and click Perform Move.

NOTE:
Only one item can be moved at a time, so it is not possible to select multiple source or destination
locations. The Perform Move button is grayed out until a valid source and destination have been selected.

With the CSI version of L&TT, from the Device Information screen for a supported library or autoloader,
use the movemedia command to access the Move Media screen. This screen is identical to the Cartridge
Inventory screen accessed with the inventory command with the exception of the screen name shown
in the top line. Use the standard keyboard commands (Ctrl+U, Ctrl+D) to scroll through the list. To
perform the move, use the move command.

move <source> <destination>

The values used for <source> and <destination> are a combination of the letter s for slot, d for drive,
or m for mailslot, and the number of the device. For example, to move media from Slot 4 to Slot 3,
enter the following command:

move s4 s3

To move media from Drive 1 to Mailslot 3, enter the following command:

move d1 m3

Possible Move Media error situations
The following errors may be encountered when attempting to move media through L&TT:

NOTE:
These errors are less common with the Windows version of L&TT because the user interface reduces the
number of possible error situations.

1. The source is empty.
2. The destination is full.
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3. The picker is full with some other media.
4. The source and destination are the same.
5. Invalid arguments were provided (for example, the slot number is too high or no mail slots

on the system).
6. Slot to slot is not supported with this device (you must move slot to drive or drive to slot).
7. The command was acceptable, but there was a SCSI error performing the move. L&TT provides

the SCSI error message along with the sense data.

Performing manual product identification
This feature (which requires a password) allows an arbitrary device to be mapped as a specific device
family within L&TT. This feature is most commonly used when the product ID (SCSI inquiry) string does not
match the string expected by L&TT. The string may have been changed or corrupted, or the product is
operating in “boot code” mode.

To manually identify a device:

1. Select a product in the device list.
2. Select Manual Product Identification from the Function menu.
3. Choose the product family that best matches the selected device.

NOTE:
For L&TT versions prior to 2.7 SR2a, manual product identification (previously called override mapping)
was performed by right-clicking the device in the device list and choosing the appropriate product family.

When manual product identification is enabled, L&TT automatically operates in a restricted mode. In
this mode, the firmware update options are pre-selected to enable selection of firmware for any product
ID and also set the "update product ID" option. To update the product ID, select the proper firmware
file and click the Start Update button.

Using the Quiet Mode feature
Depending on the quiet mode argument specified, warning and error dialog boxes may not be displayed
in quiet mode. Quiet mode has two possible arguments:

• Warning—When the warning argument is specified, L&TT does not display any warning dialogs.
L&TT assumes a Yes response to all warning dialogs and proceeds with execution.

• Error—When the error argument is specified, L&TT does not display warning or error dialogs.
L&TT assumes a Yes response to all warning and error dialogs and proceeds with execution.

CAUTION:
Quiet mode makes using L&TT more convenient by suppressing warning, error, and confirmation dialogs.
However, these same warning, error, and confirmation dialogs are intended to provide an extra level of
security to prevent you from accidentally doing something that you did not intend to do. Using quiet
mode sacrifices this extra level of security for convenience. HP does not recommend using quiet mode
unless you are thoroughly familiar and experienced with L&TT.

To enable the quiet mode feature, launch L&TT from a command prompt using the
quietmode=[error|warning] argument.

• To launch the Windows version of L&TT with quiet mode enabled, click Start > Run and enter the
following into the Run dialog box:
"C:\Program Files\HP StorageWorks Library and Tape Tools\HP_LTT.exe"
-o quietmode=[error|warning]

• For HP-UX, Tru64, and Linux, log on as root and execute the following commands:
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cd /opt/ltt
./hp_ltt -o quietmode=[error|warning]

• For Novell NetWare, from the server console, execute the following command:
hp_ltt\hp_ltt -o quietmode=[error|warning]

Using the Installation Check feature
When run in installcheck mode, L&TT can be used to check the installation of selected devices. L&TT
performs several tests on each selected device to determine if the device is configured optimally. In
addition, L&TT performs connectivity and configuration tests on all devices. These tests cannot be
overridden. All of the tests performed during the installation check can also be run manually with L&TT.

L&TT displays the results of each test and any recommendations.

The installation check feature can be run from the Start menu, or launched from a command prompt using
the mode=installcheck argument.

To launch L&TT in installcheck mode:

1. Do one of the following:
• Click Start > Run and enter the following into the Run dialog box:

"C:\Program Files\HP StorageWorks Library and Tape
Tools\HP_LTT.exe" -o mode=installcheck

• Click Start > Run and enter the following into the Run dialog box:
"C:\Program Files\HP StorageWorks Library and Tape
Tools\HP_LTT.exe" -o mode=installcheck

The Installation Check wizard is displayed.

Figure 32 Installation Check wizard

2. Select the device on which to run the installation check and click Start Verification to display the
next screen of the Installation Check wizard.

3. Select any optional tests that you want L&TT to perform. Some tests may not be available for
your configuration.

4. Click Continue Verification to begin the installation check. The third screen of the Installation
Check wizard indicates the progress of the installation check. Selected tests are executed
sequentially, and the progress of each test is displayed.
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The final screen of the Installation Check wizard displays the results of the selected tests and
any recommendations.

NOTE:
If you need to stop the installation check, click Abort Installation Check.The test is aborted after
completing the current phase of the test.

5. Click OK to close the Installation Check wizard. Closing the wizard also closes L&TT. If you want
to restart L&TT, launch it as you normally would, without the mode=installcheck argument.

Using L&TT in restricted mode
When running in restricted mode, only a few of L&TT features are available. Running in restricted mode is
not a user option. Rather, L&TT automatically runs in restricted mode when it recognizes an otherwise
supported device that has a problem with firmware and requires a firmware upgrade. There are two
basic scenarios:

• L&TT recognizes the device, but the device is in “brain dead” mode. This usually indicates that
the device firmware is corrupt and the device is responding via boot code only.

• L&TT recognizes the device by means of the product ID code, but L&TT does not recognize the
“personality” codes of the device.

If one of these scenarios exist, then L&TT displays a message stating that it is running in restricted mode
when it is started. The functionality of L&TT is restricted as follows:

• All features are disabled except for firmware update and support ticket.
• The support ticket shows basic information only and excludes device details.
• For firmware upgrades, L&TT enforces the “Allow all files to be selected” option, and the Options

button is unavailable because all options are preset.

To exit restricted mode, exit and restart L&TT. L&TT will continue to start in restricted mode until the
problem with the offending device is resolved, or the device is disconnected.

Using the Tool Status Report
The Tool Status Report (TSR) is a text file that contains information that can be useful in diagnosing
problems with L&TT. The TSR is generated automatically whenever L&TT shuts down unexpectedly. A TSR
can also be generated manually. The TSR is available from both the Windows and CSI versions of L&TT.

In the event that L&TT shuts down unexpectedly, you will be prompted with the option to send a TSR to
the L&TT support team.

To manually generate a TSR from the Windows version of L&TT:

1. Select Tool Status Report... from the Help menu to display the Tool Status Report screen.
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Figure 33 Tool Status Report screen (GUI)

2. Follow the steps outlined on the Tool Status Report screen.
3. Click one of the following buttons:

• Send as E-Mail—Click this button to send the TSR in an email. Use the default address
(ltt_team@hp.com) to send the TSR to the L&TT support team, or change the email address
as needed. This option does not show you the TSR, so if you want to view it, click Preview
before clicking Send as E-Mail.

NOTE:
Before L&TT can email a TSR, you must either have a MAPI-compliant e-mail program (such
as Microsoft Outlook or Outlook Express), or you must set up an email account through the
Windows Control Panel or Internet Explorer. For more information about setting up an e-mail
account, see How do I configure e-mail to send support tickets

• Preview—Click this button to view the TSR in a text editor.
• Cancel—Click this button to close the Tool Status Report screen and return to the L&TT Main

screen.

To manually generate a TSR from the CSI version of L&TT:

1. From the Main screen (and certain other screens), enter the report command to display the
Tool Status Report screen.
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Figure 34 Tool Status Report screen (CSI)

2. From the Tool Status Report screen, enter one of the following commands:
• preview—displays the TSR in a text editor.
• send-email—prompts you for an email address (ltt_team@hp.com is the default) and

sends the TSR to the specified email address.
• up—exits the current command level.
• exit—exits L&TT.
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8 Advanced Installation Topics

Installation types
There are currently two main Library & Tape Tools InstallShield bundles:

1. L&TT Installer, English, End-User Type (only catalogs for current version)—This is an end-user
bundle for customers that has been optimized for size, so downloads are quick. This version
can be found on the HP customer websites and allows viewing of support tickets from the same
tool version only.

2. L&TT Installer, English, Support Type (catalogs for current and all legacy versions)—This is an
internal HP support personnel bundle. This version contains the catalogs (files that contain all
the strings used in the application) for the current and all previously released versions (back to
2.5). Support personnel can read support tickets generated by the current or any previous
version of L&TT.

Other changes to the system (GUI)
The L&TT installation adds the following keys to the Windows registry:

HKEY_LOCAL_MACHINE\Software\Hewlett-Packard\HP Library & Tape Tools

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Uninstall

Reboot criteria
A reboot is required only if your system requires ASPI or an upgrade to the currently installed version. On
systems that require ASPI, if the installer detects a previously-installed version of ASPI older than v4.57, it
will install a more recent version of ASPI requiring a reboot.

On Windows NT and 2000, ASPI is not installed as part of the operating system. If a reboot is
unacceptable, do not select the checkbox for this option in the installation process. If you choose not to
install ASPI, then you must use the Miniport driver (Miniport I/O mode) to scan for devices.

Issues may arise, however, when using the Miniport I/O mode with devices that use non-standard OS
drivers, or are “claimed” by other applications or the OS. When using the Miniport I/O mode when a
device is claimed, it may be necessary to shut down any running backup/storage application services
to make the device accessible to L&TT. Alternatively, using the ASPI I/O mode may make the device
accessible without requiring any further action.

Running L&TT from a CD-ROM
It is possible to create a version of L&TT that can run directly from a CD-ROM without the need for
installation or alteration of registry settings. This feature is most useful on Windows NT and Windows
2000. On other Windows platforms, it requires WINASPI to be installed.

To create a version of L&TT that can run from a CD-ROM drive:

1. Fully install L&TT to your computer. If desired, also install any desired firmware files into the
firmware subdirectory.

2. Remove the logs directory from the L&TT install directory.
3. Write the contents of the L&TT install directory to the root directory of the CD-ROM and close the

CD-ROM.
4. Put this CD-ROM into any Windows system and run HP_LTT.exe from the root directory.
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Files installed on the system
During installation, L&TT files are installed in the following directories:

Table 2 L&TT installation directory locations

Operating System Directory Location

HP-UX, Linux, and Tru64 /opt/ltt(main executable is hp_ltt)

Netware SYS:System\hpltt(main executable is hp_ltt.nlm)

Windows C:\Program Files\HP Library & Tape Tools (main
executable is hp_ltt.exe)

Several sub-directories are created under the main installation directory. These sub-directories are as
follows:

• Catalogs—This is the location where the message strings for the software are kept. The end-user
version has only the catalogs for the latest version of code. With the support personnel
installation, catalogs are included for previous versions (back to version 2.5), so support tickets
generated by these versions can be viewed.

• Firmware—This is the default directory where firmware files are kept. When L&TT is first installed,
this directory is usually empty (unless specific firmware images were bundled - such as the 2.7
SR2 release that includes firmware for DDS3 write recalibration). The name and location of the
firmware directory can be changed from Options > Preferences.

• Logs—This is the default directory where L&TT saves event logs and support tickets. This directory
is also used to store any script-generated files such as baseline files, results files, and so on.

• Misc—This directory is used to hold test data files and L&TT history for the specific devices on the
system. These files are used by L&TT itself and not intended for direct viewing.

• Scripts—This directory contains all the device analysis rules, add-on tests, and SCSI script files.
For more information, see Tests and Utility Functions.

With Windows installations, in addition to the files installed in the main installation directory, some files
are installed outside of the main installation directory. If ASPI installation is selected or required, the
following files are added/updated (assuming that the Windows system directory is C:\WINNT):

• C:\WINNT\System\winaspi.dll
• C:\WINNT\System32\wnaspi32.dll
• C:\WINNT\System32\drivers\aspi32.sys

Other changes to the system (CSI)
The same information that the Windows version of L&TT stores in the Windows registry is stored as a text
file for the Unix versions. This text file is located in the following directory:

• HPUX & Tru64:
/.lttreg

• Linux:
/root/.lttreg
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9 Frequently Asked Questions

This chapter addresses several of the most common questions regarding L&TT software.

Windows environment

How do I run L&TT from a CD-ROM?
It is possible to create a version of L&TT that can run directly from a CD-ROM without the need for
installation or alteration of registry settings. This feature is most useful on Windows NT and Windows
2000. On other Windows platforms, it requires WINASPI to be installed.

To create a version of L&TT that can run from a CD-ROM drive:

1. Fully install L&TT to your computer. If desired, also install any desired firmware files into the
firmware subdirectory.

2. Remove the logs directory from the L&TT install directory.
3. Write the contents of the L&TT install directory to the root directory of the CD-ROM and close the

CD-ROM.
4. Put this CD-ROM into any Windows system and run HP_LTT.exe from the root directory.

How do I shut down the application in the taskbar?
Under certain circumstances, L&TT may not completely shut down. To completely terminate the
application:

1. Press Ctrl+Alt+Del.
2. Select Task Manager.
3. Click the Processes tab.
4. Select the process named HP_LTT.exe and click End Process.

When installing L&TT for Windows, should I uninstall my previous version first?
You must uninstall any previous versions of L&TT before installing the most recent version. To uninstall
L&TT, use the Add/Remove Programs applet in the Windows control panel. The uninstall procedure does
not remove the installation folder, allowing you to preserve all of your previous L&TT files such as log
files, SCSI scripts, and so forth.

Why can’t I uninstall L&TT or install a new version?
Some users may have problems uninstalling L&TT or installing a new version after installing or uninstalling
a previous version. This is caused by remnants of program information that remain in the Windows
registry.

The L&TT team has created a utility to manually remove any remains from previous installations. To obtain
this utility, download and execute hp_ltt_install_support.exe from the HP Support web site. The utility
completely removes any remains of previous installations quickly and safely.

After running this utility, rerun the latest L&TT installation package.
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How do I erase an LTO FUP tape?
For LTO, use the fw_2_data script.

NOTE:
FUP tapes other than LTO do not need to be erased.

How do I configure e-mail to send support tickets?
To successfully send a support ticket via e-mail directly from L&TT, you must have a MAPI-compliant e-mail
client set up for outgoing e-mail. Even if e-mail software (such as Outlook or Outlook Express) is not
installed, you can configure a simple e-mail account using the Internet Connection Wizard that comes
with Internet Explorer. To access the Internet Connection Wizard:

1. Launch Internet Explorer. If this is the first time to launch Internet Explorer on this machine, the
Internet Connection Wizard is displayed automatically. Follow the instructions until you reach the
step that asks whether an Internet e-mail account should be set up. Answer Yes and skip to Step
5. If this is not the first time to launch Internet Explorer on this machine, proceed with Step 2.

2. Select Internet Options from the Tools menu.
3. Select the Connections tab.
4. Click Setup at the top of the dialog to start the Internet Connection Wizard.
5. Enter a display name (this is the “From” name in the e-mail) and click Next.
6. Enter the return e-mail address and click Next. If there are no e-mail accounts on this system

that will be monitored, use your regular e-mail address at which you can be contacted by
the recipient of the support ticket.

7. Enter bogus as the address for the incoming mail server.
8. In the SMTP mail server field, enter the address of any SMTP mail server within the firewall of

your organization that accepts SMTP send requests and click Next. If you do not know which
address to use, contact your local system administator or check the mail account settings on
your regular e-mail account.

9. If your SMTP server requires a login to send e-mail (most sites only require a login for incoming
mail), you must provide proper account information. Otherwise, you can enter bogus in both
fields. Click Next.

Your e-mail is now configured for outgoing mail delivery.

Does L&TT use any system resources in the background?
L&TT is an application, not a service. No part of the application uses any system resources unless
the application is manually launched by the user.

I am using an authenticated proxy at my site. How do I configure L&TT to
connect to the HP website to download firmware updates?

L&TT uses the same connection properties as Internet Explorer. If you are unable to download from L&TT,
you can manually download the latest version of the firmware from the ftp site and place it in the firmware
directory found in the L&TT program directory.

You can access the L&TT firmware ftp site at:

ftp://ftp.hp.com/pub/information_storage/software/ltt/firmware

The firmware files are named using the following convention:

LTT_<product ID>_<firmware version>.frm

For example:

74 Frequently Asked Questions

file://ftp://ftp.hp.com/pub/information_storage/software/ltt/firmware


LTT_A5617A_0200.frm

L&TT starts in “restricted” mode and most functionality is unavailable. What is
happening?

L&TT automatically runs in restricted mode when it recognizes an otherwise supported device that has a
problem with firmware and requires a firmware upgrade. There are two basic scenarios:

• L&TT recognizes the device, but the device is in “brain dead” mode. This usually indicates that
the device firmware is corrupt and the device is responding via boot code only.

• L&TT recognizes the device by means of the product ID code, but L&TT does not recognize the
“personality” codes of the device.

If one of these scenarios exist, then L&TT displays a message stating that it is running in restricted mode
when it is started. The functionality of L&TT is restricted as follows:

• All features are disabled except for firmware update and support ticket.
• The support ticket shows basic information only and excludes device details.
• For firmware upgrades, L&TT enforces the “Allow all files to be selected” option, and the Options

button is unavailable because all options are preset.

To exit restricted mode, exit and restart L&TT. L&TT will continue to start in restricted mode until the
problem with the offending device is resolved, or the device is disconnected.

Why doesn’t L&TT for Windows “see” devices that are connected to a computer
running HP-UX?

L&TT does not support a client-server model such as the HP-UX Support Tools Manager. You cannot use
L&TT on a Windows workstation to view devices that are connected to a computer running HP-UX.

Why doesn’t L&TT for Windows “see” my USB drives?
The ASPI driver does not support USB drives. Make sure that you are using the Miniport driver.

CSI environment

How do I set the password?
With a few exceptions, you may at any time enter the options command to display the Options dialog.
The password may be set from this dialog.

Notable exceptions:

• You may not enter the Options dialog when you are already in the Options dialog.
• You may not enter the Options dialog when you are past the first screen in either the Firmware

dialog or the Test dialog.

For instructions on setting the password, see Setting passwords.

Why does my display not show any text or only a single line of text on my
HP-UX system?

Display problems can happen for two reasons:

• If TERM, COLS, and ROWS are set incorrectly there can be problems. Execute the following
command:
/opt/ltt/hp_ltt -o displaytest
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Follow the prompts to let L&TT analyze your settings.
• If the patch level of the host machine is too low, curses may not function properly (10.20 systems

only). Be sure to apply patch B6378DA or higher.

Why doesn’t L&TT for HP-UX “see” some of my devices?
Several things can prevent L&TT from seeing a device in HP-UX:

• If a device shows up in an I/O scan as “NO_HW,” this means that the device was previously
visible to the system, but currently is not. This could be because the device was unplugged
from the SCSI bus or powered down.

• L&TT does not support the NIO bus type. If your system has an HSC or PCI bus, connect your
device to that bus. If your system does not have an HSC or PCI bus, unfortunately, L&TT will
not work for you.

• The device is connected to an unsupported HBA. Connect the device to an HBA with a supported
driver. L&TT supports HBAs with the following drivers:
• c720
• c8xx
• fcpdev
• fcpmux

• If a device shows up in the I/O scan as “unclaimed,” you may have to install or enable the
tape driver kernel module using the SAM tool.

Why am I unable to download firmware/script files using the download option
in the CSI (HP-UX, Linux)?

If your network is protected by a firewall and web proxy, you must first specify the proxy server name and
port name using the Preferences screen.

Why doesn’t L&TT for Tru64 “see” some of my devices?
Whenever you connect or remove a device, you must reconfigure the CAM and hardware manager
layers. Furthermore, Tru64 does not support hot swapping of SCSI devices. To reconfigure the CAM
and hardware manager layers:

1. Close L&TT.
2. Use the following command to check for stale devices:

/sbin/hwmgr show scsi -full | grep stale
3. Remove any stale devices. If you are not sure whether a device is stale or not, remove it anyway.

Devices can be rediscovered later. Use the following command to remove a device:
/sbin/hwmgr -delete scsi -did <SCSI ID>

4. Rescan the SCSI bus.
/sbin/hwmgr scan scsi

5. Rescan the CAM layer.
/sbin/scu scan edt

6. Run the following commands to verify the SCSI devices:
/sbin/hwmgr show scsi
/sbin/scu show edt

7. Restart L&TT.
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Why doesn't L&TT for Linux "see" some of my devices?
To detect a surrogate SCSI device, you must configure the modules.conf file for the new device you have
connected. After modifying this file, reboot the computer so that the new device is recognized by the
scsi/sg layer. Linux does not support hot swapping of SCSI devices. To reconfigure the modules.conf file:

1. Login as root.
2. Edit the following file:

vi /etc/modules.conf
3. Add the following line as appropriate:

add options scsi_mod max_scsi_luns=128
4. Reboot the computer.

Why doesn’t L&TT for Windows “see” devices that are connected to a computer
running HP-UX?

L&TT does not support a client-server model such as the HP-UX Support Tools Manager. You cannot use
L&TT on a Windows workstation to view devices that are connected to a computer running HP-UX.

How do I disconnect a SCSI device in Tru64?
1. Locate the SCSI device in hardware manager:

/sbin/hwmgr -show scsi
2. Use the following command to delete the SCSI device.

/sbin/hwmgr -del scsi -did <SCSI ID>
3. Disconnect the device.
4. Make sure that you have removed the corresponding SCSI cable from the HBA.

How do I connect/disconnect a SCSI device in Linux without rebooting?
• To add a new device, connect the device and run the following command:

echo "scsi add-single-device <hostid> <busid> <targetid> <lunid>"
>/proc/scsi/scsi

• To remove a device, run the following command and disconnect the device.
echo "scsi remove-single-device <hostid> <busid> <targetid> <lunid>"
>/proc/scsi/scsi

Why doesn’t L&TT for OpenVMS “see” my media changer?
OpenVMS does not automatically recognize media changer devices. Media changer devices must
be associated with the GKDRIVER (generic SCSI driver). To associate media changer devices with
GKDRIVER, use the following command in OpenVMS:

SYSMAN IO CONNECT <devicename> /DRIVER=SYS$GKDRIVER /NOADAPTER

The form for <device name> is G<x><z><uuu> where:

• <x> indicates whether the media changer is connected to a SCSI or Fibre Channel HBA.
• Use “K” for SCSI.
• Use “G” for Fibre Channel.

• <z> is the HBA identifier (A-Z).
• <uuu> is the SCSI target ID and LUN ID combined.

For example, with a media changer having SCSI target ID 4, LUN ID 0, and connected to the second
SCSI HBA, the device name is GKB400.
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• “G” indicates that this device is associated with the generic SCSI driver (GKDRIVER).
• “K” indicates that the device is connected through a SCSI interface.
• “B” is the second SCSI HBA (HBAs typically have names from A to Z).
• “4” is the SCSI target ID.
• “00” is the SCSI LUN ID.

Why am I getting "Error activating image PTHREAD$RTL" while running L&TT
on OVMS 7.3-1?

L&TT on an OVMS 7.3-1 system requires the "VMS731_UPDATE V5.0" patch (or a later version) for
proper execution.
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Email Support Ticket dialog box (GUI), 57
emailing, support ticket, 54, 57
erasing an LTO FUP tape, 74
ESL vendor ID test, 42
event log

described, 60
using, 60

exclusive use of device by L&TT, caution, 35
exit command, 29

F
Factory Firmware Overrides dialog box (GUI),
36
factory password, obtaining, 54
features, 13
files installed on the system, 72
find command, 59
firmware
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acquiring (CSI), 36
advanced options (GUI), 36
allow downgrading, 36
allow selection of any file, 36
directory, 33
downloading, 33, 33, 37
files, acquiring, 33
selecting files, 34
update activity log, 35
update product ID option, 36
uploading to devices, 35
uploading to devices (CSI), 37
viewing revision history, 35

firmware command, 37
firmware file path option, 62
Firmware Management screen, GUI, 26
Firmware Update screen (GUI), 35
Front Panel function, 63
Front Panel screen (GUI), 64
full sweep test, 41

G
Get Files from Web dialog box-firmware tab
(GUI), 34
Get Files from Web functionality

CSI, 37
GUI, 33

H
HP-UX

installing L&TT, 16
starting L&TT, 27
Support Tools Manager, 77

I
I/O mode

ASPI, 16, 22, 71
Miniport, 16, 21, 23, 71

icons, GUI and CSI, 15
improper script usage, caution, 52
initialize element status test, 41
installation

ASPI, 16
changes to Windows registry, 71
directories created, 72
files installed, 72
HP-UX, 16
Linux, 16
NetWare, 16
problems installing or uninstalling, 73
reboot criteria, 16, 71
Tru64, 16
types of, 71
uninstalling L&TT, 15, 73
upgrading from previous version, 15, 73
Windows, 15

Installation Check feature, 67
Installation Check wizard, 67
installcheck mode, 67
Instructions tab, 23
Internet Connection Wizard, 74
Internet Explorer, 74
Internet update functionality, using, 63
interrupting firmware update, caution, 37

L
L&TT

display problems, 75
features, 13
main screen layout (GUI), 22
problems seeing devices, 76, 76, 77, 77
running from a CD-ROM, 71, 73
safeguards, disabling, 37
splash screen, 19
starting

for HP-UX, 27
for NetWare, 27
for Tru64, 27

starting for Windows, 19
supported operating systems, 13
supported products, 13
terminating, 73
uninstall utility, 73
use of system resources, 74
using with an authenticated proxy, 74

library exerciser test, 40, 50
Linux

disconnecting a SCSI device, 77
installing L&TT, 16
starting L&TT, 27

load command, 59
log directory, 53
log file, 53
log file path option, 62
LTO cooling check test, 41
LTO firmware tape creator test, 41
LTO FUP tape

erasing, 74
LTO tape stress test, 41

M
Main screen (CSI), 29
manual product identification feature, 66
MAPI-compliant email programs, 57
media analysis test, 42, 50
media erase test, 42
media validation test, 40
Miniport, 21, 23

driver, 16, 71
I/O mode, 16, 71

MO media validation test, 42
Move Media function, 64
Move Media screen (GUI), 65
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N
navigation, screen, 29
NetWare

installing L&TT, 16
starting L&TT, 27

O
OpenVMS

using with media changers, 77
options command, 37
Options screen (CSI), 37

P
page command, 52, 59
password

entering, 38
obtaining, 36, 37, 54
setting, 63, 75

picktest command, 51
preferences

available options, 62
setting, 61

preferences command, 62, 63
Preferences dialog box

CSI, 62
GUI, 61

Q
Quiet Mode feature, 66

R
read/write test, 40, 49
restore factory settings test, 41
restricted mode, 68, 75
review command, 37, 52

S
save command, 59
Saved/Manual Scan screen, 21
Saved/Manual Scan screen (CSI), 28
scan mode

CSI, 28
GUI, 20

Scan Mode Selection screen, CSI, 28
Scan tab, 22
screens

Command Help (CSI), 29
Device Information (CSI), 30, 30, 31
Device Information (GUI), 23, 24, 25
device list (GUI), 22
Device Performance (CSI), 45
Drive Performance (GUI), 44
Email Support Ticket dialog box (GUI), 57
example support ticket with normal detail
(GUI), 55

Factory Firmware Overrides dialog box
(GUI), 36
Firmware Management (GUI), 26
Firmware Update (GUI), 35
Front Panel (GUI), 64
Get Files from Web dialog box-firmware tab
(GUI), 34
L&TT main screen (GUI), 22
Main (GUI), 22
Move Media (GUI), 65
navigating, 29
Options (CSI), 37
Preferences (CSI), 62
Preferences (GUI), 61
Saved/Manual Scan, 21, 28
Scan Mode Selection (CSI), 28
splash screen, 20
Support Ticket Generation (GUI), 27
System Performance Backup Pre-Test (CSI),
48
System Performance Backup Pre-Test (GUI),
47
System Performance Restore Pre-Test (CSI), 48
System Performance Restore Pre-Test (GUI),
46
Tabular View, 56
Tests (GUI), 26

script file path option, 62
scripts directory, 52
SCSI scripts, 39
select command, 29, 30
show instructions option, 62
show scan details option, 62
skip this dialog in the future, 22
splash screen, 19
start command, 37, 51
support resources, 14
support ticket

comparing, 58
compressing, 58
converting to HTML, 53
detail level, 53, 54
email setup, 57, 74
emailing, 54, 57
event data, viewing, 56
event explanation, viewing, 56
example screen, 55
exporting data, 56
generating, 53, 53, 59
information reported, 59
log file, 53
other functionality, 56
reference data, viewing, 56
saving, 54
tabular view, using, 55
viewer, 53
viewing, 54, 54, 59

Support Ticket Generation screen (GUI), 27
swapping SCSI devices, caution, 23
System Performance Backup Pre-Test, 47
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System Performance Backup Pre-Test screen
(CSI), 48
System Performance Backup Pre-Test screen
(GUI), 47
System Performance Restore Pre-Test, 46
System Performance Restore Pre-Test screen
(CSI), 48
System Performance Restore Pre-Test screen
(GUI), 46
System Performance Test, 45

T
tabs

By Connection, 23
By Product, 23
Drive Information, 25
Instructions, 23
Scan, 22

Tabular View window, 56
taskbar, 22
test command, 51
tests

assessment, 41
connectivity, 40
data compression, 40
DDS firmware tape creator, 41
descriptions, 39
destructive to media, caution, 39
Device Analysis, 49
device analysis, 40
device self-test, 40
diagnostic, 40
DLT firmware tape creator, 41
DLT SRAM check, 41
drive performance, 40, 43
ESL vendor ID, 42
full sweep, 41
initialize element status, 41
library exerciser, 40, 50
LTO cooling check, 41
LTO firmware tape creator, 41
LTO tape stress, 41
media analysis, 42, 50
media erase, 42

media validation, 40
MO media validation, 42
overview, 39
read/write, 40, 49
restore factory settings, 41
running (CSI), 51
running (GUI), 51
System Performance, 45
system performance, 40
viewing (CSI), 52
viewing (GUI), 51

Tests screen (GUI), 26
Tool Status Report

CSI, 69
GUI, 68

Tru64
disconnecting a SCSI device, 77
installing L&TT, 16
starting L&TT, 27

U
uninstall utility, 73
update product ID option, 36
upgrading from previous version, 15, 73
utility functions, 39

described, 52
using, 52

V
view command, 59

W
websites

HP support, 33, 37
L&TT tapetools, 14

Windows
ASPI support, 16
installing L&TT, 15
Internet Explorer, 74
reboot criteria, 16, 71
starting L&TT, 19
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